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1 Software Introduction

VMP, short for Vision Management Platform, is an application in the brand - new control system COEX series.
Featuring innovative interaction design and plenty of practical ~ functions, such as project management, screen
configuration, input settings, display correction, color processing, screen settings, system backup, monitoring and
maintenance, screen brightness schedule, and preset management, it provides users with an effi  cient and easy

operation and control experience.
4  Easy and convenient management at screen level

Devices of the same model and version can be added to the same screen for management, allowing for

batch operations and greatly increasing work efficiency.
4  Fast and flexible configuration

The cabinets can be quickly connected, flexibly arranged and aligned, significantly simplifying screen

configuration.
4 Distinct topology area and properties areas

The screen topology is clear at a glance, the input source can be previewed in real time in the topology area

and various properties can be easily set.
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2 Ul Introduction

Figure 2-1 Ul Introduction

Menu Bar Function Tabs

(offline Project +

New Project

7]} New Screen Group 1

Canvas

Position

Cabinet

l

®
Project List Port List  Topology Area Properties Area

BNote:

All the figures in this document use operations in Windows10 as examples.
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3 Install VMP

3.1 Windows

Prerequisites

The VMP software package is prepared.

A computer meeting the following requirements is available.
OS: Windows 10 (64- bit) or later
CPU: i5 or later

RAM: 8 GB or greater

BNote:

ARM- based Windows computers are not supported.

Installation Method

Run the Coex VMP Setup.exe and follow the setup wizard to complete the installation. If a firewall prompt

appears, choose to allow the installation.

Installation Result

If the installation is successful, the VMP software shortcut % appears on the desktop.

3.2 MacOS

Prerequisites

The VMP software package is prepared.

A computer meeting the following requirements is available.
OS: MacOS 10.15 or later
CPU: Intel i5 or Apple M1 or later

Memory: 8GB and above

Installation Method

Step 1 After the installation package is downloaded, click Finder on the desktop, enter the Downloads page, and

double -click the package to open VMP.dmg.

o,

Step 2 Hold down the control key, click 288 and select Open.

www.novastar.tech ey 3
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Figure 3-1 VMP for Mac

VMP for Mac

Step 3 In the Install VMP window, follow the installation guide to complete installation.

Figure 3- 2 Install VMP
[ N « Install YMP

Welcome to the VMP Installer

® Introduction You will be guided through the steps necessary to install this
software.
Jestination ¢

nstallatic
nstallatior

aummary

Continue

Installa tion Result

If the installation is successful, the following window is displayed and the VMP software shortcut E appears in
Launchpad.
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Figure 3-3 Successful installation
] « Install VMP

The installation was completed successfully.

Introduction

Destination Select
Installation Type
Installation

® Summary

The installation was successful.

The software was installed.

4 Device Management

4.1 Connect Online Controllers

Via Ethernet Cable

Step 1

Step 2
Step 3

Step 4

Connect the controller and the control PC directly via Ethernet cable and set a static IP address for the controller
to let the controller and control PC be on the same network segment. The MX40 Pro LED display controller is

used as an example in this section.

Follow Figure 4-1 to complete the hardware connection.

Figure 4-1 Connecting devices via Ethernet cable
e < B
Sag et MX40 Pro

~~~" Ethernet & [ : Ethernet
¢ > < >

LED Screen

, s—
Control PC

% : =

HDMI/DP/SDI Cable

Input Source

Input
Output
Control

Press the knob of the controller to enter the menu and choose  Communication Setti ngs > Network Settings
Set Mode to Manual .

Set IP Address, Subnet Mask and Default Gateway and ensure the controller and control PC are on the same

network segment.

To reset the network settings to the default values, please select Reset and press the kno b.
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Step 5 After the settings, select Apply and press the knob.
Via LAN

Connect the controller and the control PC to the same LAN via a router and set the controller to automatically
obtain an IP address. The MX40 Pro LED display controller is used as an example i n this section.

Step 1 Follow Figure 4-2 to complete the hardware connection.

Figure 4-2 Connecting devices via LAN

LED Screen

MX40 Pro

Ethernet

»(Onn

T O
[ M=, P
Ethernet

——— Ethernet
Control PC

Router 2

HDMI/DP/SDI Cable

Input Source

Input
Output
Control

Step 2 Press the knob of the controller to enter the menu and choose  Communication Settings > Network Settings
Step 3 Set Mode to Auto .

Step 4 Select Apply and press the knob.

Related Information

If the controller and the control computer are on the same LAN but on different subnets, the controller may not
appear in the project list after connecting. To resolve this, you can search for the controller by its IP address and

add it to the project list. For detailed instructions, please referto  4.3.2 Adding Controllers via IP Search .

The online controllers that are connected will be categorized according to the projects, screen groups, and

individual screens of each controller. Any new controllers will be shown in the default project.

For card- based controllers like the MX6000 Pro and MX2000 Pro, you can install diff erent models of output
cards for the same controller. However, output cards  with different Ethernet port bandwidths (1G/5G) do not

support loading the same screen.

4.2 Add Offline Controller

Before the LED screen is constructed on - site, you can add offline controllers and pre - configure the screen
settings. You can then easily import the pre -configured project settings for swift and hassle -free usage of the

LED screen.

Operating Procedure

Step 1 From the menu bar, choose Tools > Offline Mode > Enter Offline Mode
Step 2 Click at the top left and then select Add Controller to add offline controllers.

Step 3 Add one or multiple devices as needed.
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You can add up to 100 offline controllers in VMP, only 25 controllers can be operated at the same time. For card -
based controllers, you can run up to 4 fully -configured MX6000 Pro or 12 fully - configured MX2000 Pro at the
same time.

When the number of controllers exceeds the limit, some controllers will enter sleep mode. You can wake them by
clicking on the sleeping controller or its associ ated screen, which will also wake up any offline controllers linked to
that screen. Meanwhile, the system will put the controllers that haven't been used for the longest time into sleep

mode.
Step 4 Click Add Controller in the pop -up window.

To add multiple contr ollers of the same model, click Batch Add .

Figure 4-3 Add controller

Add Controller

No. Controller Model Card Type Name IP Address Operation

1 MX&000 Pro IN (1/8) /8 [4 MX6000 Pro_1 192.168.0.14 o mr

Controller 89 Batch Add

| Cancel |

Step 5 Enter the controller model, controller name, and IP address.

—
For card-based controllers like the MX6000 Pro and MX2000 Pro, click to enter the input/output card
model. You can install different models of output cards for the  same controller. However, output cards with

different E thernet port bandwidths (1G/5G) do not support loading the same screen.

Click to copy the current contr oller and click 1 to delete it.

Step 6 Click OK once you are done.

Related Information

The added offline controllers will be displayed at the bottom of the selected project/screen.
When no target is selected, added offline controllers will be displayed at the bot  tom of the Default Project.

In offline mode, when configuring the screen, it's possible to mix cabinets of different sizes with the same model

receiving cards.

. To exit offline mode, choose Tools > Offline Mode > Exit Offline Mode , or close VMP and reopen it.

4.3 Manage Project List

The project list is categorized into four levels: project, screen group, screen, and controller. Screen groups,

screens, and controllers can be added to the project for centralized management and batch operations.
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This chapter will introduce the operations related to the project list by using the example of creating a new

project and screen.
4.3.1 New Project/Screen Group/Screen

Step 1 To create a project, click and then select New Project from the pop -up menu.

To delete a project, right -click the project and then select Close from the pop - up menu.

Figure 4-4 Project list

Offline Project +

New Project

v [[] New Screen1
3 MX40 Pro_2 (Primary)

5 MX40 Pro_1 (Backup)

[] NewScreen3

)00 Pro_1_OUT 1

Pro_1_OUT7

5 MX6000 Pro_1_OUT 8

Step 2 To create a screen/screen group, click and then select New Screen Group /New Screen .

When you have multiple screens in the project, you can drag a screen to overlap with another one  and create a

screen group.

You can drag and drop a screen group or screen to another project.

Step 3 You can also drag and drop a controller to another screen.
Controllers and output cards of different models or firmware versions cannot be added to the same scree n.
Dragging a controller to a new screen will apply all the sending card parameters of that screen.

Click the E icon at the top right of the list to hide controllers and only show projects, screen groups, and

screens.

4.3.2 Adding Controllers via IP Search

If th e controller and the control computer are on the same LAN but on different subnets, the controller may not

appear in the project list after connecting. To resolve this, you can search for the controller by its IP address and

add it to the project list.

Step 1 Click and then select Add Controller from the pop -up menu.
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N Project  Edit  View

Online Project +

New Project 1

Add Controller

No. 1P Address Controler Type

Step 2 Enter the IP address and verify the controller's status, name, and model.

Step 3 Click OK to add the controller to the project list.
4.3.3 Unified Settings Adjustment for Projects/Screen Groups

By selecting a project or screen group, you can uniformly control the screens within the group/project and
perform various batch operations.

View the number of screens, controllers, and cabinets, along with their current operating status.
Adjust image quality settings , such as brightness, color temperature, and color gamut.

Control the display, including functions like blacking out the screen or freezing the image.
Easily switch between saved preset configurations.

Screen Controller Cabinet
2

1 8

Adjustment Display Control
Brightness

Gamut

Color Temperature

@ Blackout

Preset

1 Preset 1

o=l

4.3.4 Rick-click Menu

Rename

Right- click a project/screen group/screen/controller and then select Rename from the pop -up menu.
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Screen Control

Right- click a project/screen group/screen/controller and then select

menu.

Enable Mapping

Right- click on a screen/controller and select Mapping , Controller Identify

pop - up menu.

4 Mapping

VMP Vision Management

Platform User Manual

Activating the Mapping feature allows you to clearly identify the location and wiring path of the receiving

cards.

4  Controller Identify

Turn on the controller identify feature and  set the display color on the controller's LCD. This will help you

quickly identify the controller.

Rename

Controller Properties

Remove from the current screen
Move To

Blackout Alt+B
Freeze Alt+F
Mapping
Controller Finder

»
~ Disable

Canvas Mapping

Move Down

Move to Bottom

Delete

4  Canvas Mapping

Enable the canvas mapping feature to quickly view the position of the canvas on the LED screen.

Controller Properties

Right- click a controller and then select Controller Properties

www.novastar.tech
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Controller Properties b3

MX6000 Pro_1 (Export Log )

Date and Time v

Automatic Time Setting From Computer

Controller Time Timezone (UTC+08:00) PRC

Basic Information v

Model MX&000 Pro Free EMMC capacity 5.1GB
Q29WHSVWEeMG93517 Eth speed 1Gbps & 5Gbps
V15.0 Time since boot 0d-0h-4min

5 192.168.0.12

MAC 00:11:22:35:38:13

Detailed Information

Controller and System AUX

SN V0.0.0 SN 61d226bd48264f38a490ac5q...
Hardware VL0.0 Firmware V1.0.0.060901

Hardware V1.0.0

Input Card > Output Card

4 Date and Time
Auto Sync:

1. Toggle on Automatic Time Setting (). You can choose to sync from either the Computer or an
NTP Server.

U  If you select Computer , the controller's time will be synchronized with the control computer's time.

U  Ifyou select NTP Server, you can manually enter the NTP server address and select your timezone
and daylight saving settings to obtain the correct time for the chosen timezone.

2. Click Sync Now to complete the time setting.
Manual Adjustment:
Toggle off Automatic Time Setting (C‘) and click Controller Time to manually adjust the time.
4 Basic Information
Check the controller model, SN, firmware version, IP address, MAC address, et c.
4  Detailed Information
Click a to expand the panel and check the detailed controller hardware and software information.
4 Input/Output Card Information

Check the input/output card name, model, SN, firmware version, hardware version and other information
when connecting to card -based controllers (MX6000 Pro and MX2000 Pro).

4  Export Logs

Click Export Log , select a location, set the file name, and click Save.

4.4 Export and Import Project

Export the project files (.nprj) so that you can import the files to apply the configuration data to the same kind of

controllers, improving the configuration efficiency.
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Prerequisites

The project file can be imported to a controller that is of the same model. For card - cased controllers (MX6000
Pro and MX2000 Pro), you also need to make sure the card slot and model in the file match the controller.

If the project file version is higher than that of the controller, you will be prompted to upgrade the controller
firmware during the import. Please note that the features of the new versi  on will not be supported by the
controller.

If the project file version is lower than that of the controller, you can import it without any issues.

Export Project Files

Step 1 From the menu bar, choose Project > Export and select a project.
You can also right - click a project and select Export from the pop - up menu.

Step 2 Select a local directory and click Save.

Figure 4-5 Successful export

Import Project Files

Step 1 From the menu bar, choose Project > Import and select a device or device group.
You can also right - click a project and se lect Import from the pop - up menu.
Step 2 Select a local project file and click Open.

After successful device matching, a dialog box as shown in  Figure 4-6 is displayed.
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Figure 4-6 Matching devices

Import Project File (Project 1)

File Controller Offline Controller

MX40 Pro_1 MX40 Pro_1 v ((New )

No. File Controller Offline Controller Match Result Operation

MX40 Pri MX40 -
= Manual Match Success (]

\ Cancel |
Step 3 Click OK. After importing, the original screen and controller names will be overwritten.

Figure 4-7 Successful import

Exported

4.5 Manage Peripherals

VMP supports detecting all 3D emitters, multifunction cards, and light sensors connected to  the project

controllers, as well as enabling power control through the multifunction cards.

Applicable Products

3D emitters: EMT200, EMT200 Pro
Multifunction card: MFN300

Light sensor: NS060
Notice

When system backup is set, only the primary controller/card/Ethernet port can detect and read information from
multifunction cards and light sensors. Backup controller/card /Ethernet port does not support detecting or
reading this information.

It is recommended to connect the multifunction card to po  rt 1 of the con troller. For the multifunction card

MFN300- B V4.4.2.0 and above, connect to any of the first 16 ports of the controller.
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If multiple controllers with light sensors are connected to the same screen and are placed in environments with
differen t brightness levels, ensure proper communication between the  controllers when adjusting screen
brightness via the brightness strategy table. Otherwise, inconsistencies in screen brightness may occur.

Related Information

Light sensor a mbient brightness rule s: Thelight sensor checks the brightness every 10 seconds and adjusts
every minute. During adjustment, it discards the highest and lowest values from the five most recent readings

and calculates the average to determine the ambient brightness.

A single controller can connect to multiple multifunction cards, with e ach card supporting up to four light

sensors. When multiple light sensors are connected, the average ambient brightness from all  sensors is used.

Operating Procedure

Step 1 Select a project from the project list.

Step 2 In the Peripheral section of the project list, you can check the 3D emitters and multifunction cards connected to

all the controllers within the project, as well as the light sensors connected to the multifunction cards.

Figure 4-8 Check peripheral ( multifunction card )

Online Project + Multifunction Card

Step 3 Select a peripheral to view its information in the properties area on the right.

3D emitter: You can view the model, position, and firmware version.
Multifunction card: You can view the model, position, and firmware version.
Light sensor: You can view the position and ambient brightness.

Light sensor ambient brightness rules: The light sensor checks the brightness every 10 seconds and adjusts
every minute. During adjustment, it discards the highest and lowest values from the five mostrec  ent readings

and calculates the average to determine the ambient brightness

Step 4 Perform power control operations as needed.
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Figure 4-9 Power control

N

Online Project + Multifunction Card

Select a multifunction card and set the power control mode in the properties area on the right. You can choose
between the auto and manual mode. You can also click Power on or Power off to control the state of all power

channels.
Manual mode: Set the state of each individual power channel.

Auto mode: Different start and shutdown times can be set for each power channel, with default times retrieved
from the multifunction card.

4.6 Art- Net Control

Enable the Art - Net protocol switch to realize control via third - party controller.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Prerequisites

To apply the Art - Net protocol, make sure the transmitter ends (such as console and control PC) and the receiver

ends (such as LED display control system and lighting system) are on the same LAN.

Related Information

After the Art - Net protocol switch is enabled, the configured parameters cannot be modified. For the protocol

details, see Art- Net Protocol Instructions .

Operating Procedure

From the menu bar, choose Tools > Control , enable the Art - Net switch. Set the Start Address and complete the

Source, Image Quality and Preset parameter configurations.
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Control (New Screen 2)

Art-Net @

Universe

Configuration

Start Address

Channel  Property
Brightne:
Color Temperature
splay Mode
Select Source
Black Level
Contrast
Saturation
Hue
Red Shadow
Green Shadow
Blue Shadow
Red HighLight

Green HighLight

nl T
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5 Screen Configuration

5.1 Edit Screens

Edit the settings of the selected screen.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Operating Procedure

Step 1 Select a screen from the project list and then select Layout .

Figure 5-1 Layout

Project  Edit

Offline Project +

New Project

Position

Step 2 Click Edit in the properties area on the right.

Step 3 Enter a screen name on the pop - up window.

Figure 5-2 Edit screen

Edit Screen

Screen Name New Screen 1
Working Mode All-In-One Controller @ Send-Only Controller

Low Latency

Alignment Dj D]] Dj

Pixel To Pixel

Processor Latency 1frames

OK I Cancel I

Step 4 Select a Working Mode . When operating as a Send-Only Controller , the display latency is reduced by 1 frame.

Step 5 SetLow Latency .
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When low latency is set to ®0), the latency at the data sending end is reduced by 1 frame.

Step 6 When a card- based controller (MX6000 Pro or MX2000 Pro) operates as a Send- Only Controller , you also need

to do the following.
1. Choose a layer alignment from the four options.

For IEI m or m you can adjust the layer size by dragging the layer divider, or settin g a value under
the Canvas Size section.

Position

Cabinet

2. Set the state of Pixel to Pixel .

When Pixel to Pixel is enabled (#0)), it will output the display based on the size of the input source in a

pixel-to- pixel manner.

When Pixel to Pixel is disabled (CIP), the input sour ce will automatically scale to fill the layer based on the

configured layer size.

Step 7 Click OK once you are done.

B Note

Please note the following when using the low latency function:
Low latency, frame multiplication, and 3D cannot be enabled at the same time.
When low latency is enabled, the sync source cannot be set to Genlock.

To enable low latency, please make sure all Ethernet ports load the cabinets vertically and share the same Y
coordinate. Free screen configuration (for example, Ethernet port 2 loads ¢ abinets horizontally, or its Y
coordinate is different from that of Ethernet port 1) will reduce the load capacity. For specific cal culations,

please contact NovaStar technical support.
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5.2 Set Canvas Size

Step 1 Select a screen from the project list and then selec t Layout .

Step 2 In Canvas section, select a pre - defined resolution from the drop -down list or customize the width and height of

the canvas. The maximum supported setting is 16,384.

The system will automatically calculate the maximum frame rate for the canvas bas ed on the current resolution.

Figure 5-3 Canvas

Canvas

3840°2160

128.00Hz

Step 3 Select the canvas in the canvas area and enter the X and Y coordinates to adjust the canvas starting position.

Step 4 When a card-based controller (MX6000 Pro or MX2000 Pro) operates as a Send-Only Controller , you can set the

layer divider.

For m m or Im you can adjust the layer size by dragging the layer divider, or setting a value for the

divider.

3 Position

Cabinet

5.3 Configure Screen Topology

Configure the cabinet topological diagram to complete the logical connection of the cabinets.

Prerequisites

The controller is connected and cabinets are connected to the controller.
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Operating Procedure

Step 1 Select a controller from the project list and then select Layout .

Step 2

s
s

s

Figure 5-4 Layout

Offline Project -+

New Project

Canvas

Position

Port List

Cabinet Settings

Select a view for the topology area, and choose what to display on the  topology.

Select a view or switch pages by clicking one of the icons in the top right corner of the topology area:
E Show the cabinets only.

B

Show the preview image of the input source only.

£

: Show both the cabinet and the input source preview, with th e cabinet on top.
: Show both the cabinet and the input source preview, with the input source on top. In this view, you can

Source
click - to navigate to the Source interface, then click and hold the left mouse button within the topology
to select and move layer s.

(G ] . . . .
-: Click to enable Source Snapshot . When this is enabled, the source playback in VMP will freeze on the last
frame and the display on the LED screen will not be affected. Users can then adjust screen settings based on the

frozen image without needing to look at the LED screen. To disable Source Snapshot , simply click the icon
again.

@ Page1

: Click to switch pages in the dropdown menu. VMP supports a fixed total of 8 pages. When

multiple screens are displaying the same content, you can configure screen layout a t different pages and choose

to show or hide them as needed. Click . to clear all topologies.
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In the topology area, you can choose to display the cabinet topology, cabinet status, group names, source tags,

and overlapping cabinets.

Select an Ethernet port at the bottom and then drag or click the mouse in the topology area to add cabinets.

E Note

Offline p rojects created in In VMP V1.5.0 allow a single Ethernet port to support 512 cabinets. However, for

projects creat ed in versions prior to V1.5.0, the maximum number of cabinets per port remains capped at 32.

The cabinets will be automatically connected when you are adding them, as shown in  Figure 5-5. The Ethernet
port's load capacity information will be displayed, as shown in  Figure 5- 6. The properties area will display the
cabinet specifications, as shown in Figure 5-7. You can also select a custom cabinet and click Edit to modify the

specifications of the cabinet.

Figure 5-5 Cabinets connected automatically

] ] C ] ] o

16/-: Indicates that Ethernet port 1 has 16 cabinets added to the topology.

90%: Indicates these 16 cabinets have used 12% of the Ethernet port's capacity.
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Figure 5-7 Change cabinet model (only available in offline mode)

A Change Model

-

-
TR
WA
- Resolution  Pixel Pitch R Card

B Note

Swift Layout: To use the Swift Layout feat ure, all Ethernet ports must have cabinets with the same model,
resolution, quantity, and topology. Additionally, there should be no single cabinet completely outside the
canvas. When these conditions are met, the Swift Layout feature can quickly add and ¢ onnect cabinets for
all Ethernet ports.

Swift Layout

Operating procedure: Click d and then drag the mouse on the canvas to add cabinets that

match the actual requirements. In the properties area, select a layout and click Done.

Step 4 Select other Ethernet ports and continue to add cabinets until all cabinets are connected.

Step 5 For cabinets that have the same size and consecutive serial numbers, if you want to change the cabinet
connection topology, select the cabinets and then select a quick topology under Quick topo in the prope rties
area, as shown in Figure 5- 8. For other cabinets, skip this step.

Figure 5-8 Quick topology

Quick topo

Step 6 Do any of the following to arrange, align, or copy the  cabinets and cabinet groups to let the cabinet positions

meet the display requirements.
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4 Use the function buttons

More Alignments

Fit Screen  Grid Align Left Align Right | Cabinet Topolagy

l J I l BT Align Top
Undo Redo Zoom Out ZoomIn  Zoom to Selection Coordinate Ruler

88 Align Bottom

: Arrange Top

Arrange Left

1:1: The canvas size equals to the input source resolution.
Zoom To Selection: The selected element is zoomed and displayed in the center of the canvas.
Fit Screen: The canvas size is automatically adjusted to fit the topology area size.

Coordinate Ruler: Show coordinate ruler on the left and top sides of the canvas.

Click to show its drop - down menu shown below. The menu can be used to set th e canvas grid.

Grid

Color

Y 10px |5

p To Cabinet

@ Snap To Grid

Grid: When the switch is in the ®) status, a grid is displayed on the canvas. If you do not need to
display the grid, set the switchto CIl.

Color: Set the grid color.

Spacing: Set the spacing of horizontal and vertical lines of the grid. The spacing is set to the resolution of

the first cabinet by default.

Snap to Cabinet: When positioning a cabinet near another one, the cabinet being moved will

automatically align and snap to the edge of the adjacent cabinet, effectively eliminating gaps.
Snap to Grid: The cabinet will be snapped to the grid.
Click = to enable the manual cabinet topology adjustment.

Left- click a cabinet to manually connect any unconnected cabinets or to adjust or remove existing

connections.

Right- click a cabinet to assign a n Ethernet port to the selected cabinet.

Only unused Ethernet ports can be assigned, and once assigned, all cabinets in the connection will be

redirected to the new port.
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Port 2 1 Port 12
Port 3 [J Port 13
Port 4 1 Port 14
1Port5 (] Port 15

Port 6 1 Port 16
Port 7 Port 17
Port 8 [ Port 18
1 Port 9 1 Port 19
Port 10 1 Port 20
Port 11 1 Port 21

4 Use the function menus on the menu bar

Edit menu

Edit

Undo

Group Ctrl+G

Delete

Align

View menu

View Taols

Zoom In
Zoom Qut
Zoom 1:1

Zoom to

4  Right click the cabinet

Select String

Change Model

Select Same Cabinets
Blackout

Freeze
Cir+G
Move To

Specify Port
Lock

Copy Ctrl+C

Delete Del

Select String: Select all the cabinets on the connection line of the current cabinet.

Swap: Swap the positions of the two selected cabinets.
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Group: Group the selected cabinets. To set the group name and color, please select the group and set

them in the properties area.
Ungroup: Ungroup the cabinets.
Add to: Add the selected cabinets to a group.

Move to: Move the selec ted cabinets to the chosen page (o0 nly supports selecting ¢ abinets from the same
string).

Specify Port: Move the selected cabi net to the chosen Ethernet port (0 nly supports selectin g cabinets

from the same string ).
Copy: Duplicate the selected topology, including the cabinets and connection.
Paste: Insert the copied topology.

4  Set cabinet coordinates and rotation

Select a cabinet and set its coordinates and rotation angle in the properties area. After the cabinet is
rotated, the input source will be rotated by the set angle and displayed.

EFL I Ei8ZLT OBTETS8HZ §Z §Z210LZLZTP OLETOUQds,a8P bBZyl
detailed below:

Table 5- 1 Receiving cards supporting cabinet rotation

Model Description

XA50 Pro, CA50E, A10s Pro and its derivative cards. Supported by all versions.

AbBs Plus, A7s Plus, A8s N, A8s Pro and its derivative cards. | Supported by V4.9.0.0 or later.

5.4 Set the Cabinet

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Operating Procedure

Navigate to Layout and select a screen. Do any of the following operations in the cabinet settings area.

Figure 5-9 Cabinet settings

Cabinet Settings

Normal

4  Control Display Status
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Set the Blackout or Freeze switchto #0),
4  Enable Indicator
If the cabinet has a running status indicator, you can set the Indicator switch to .
- Green: The cabinet is fully within the canvas, with normal temperature and voltage.
- Yellow: The cabinet is partially outside the canvas, with temperature  or voltage warnings.
- Red: The cabinet is completely outside the canvas, with temperature or voltage fault s.
- Gray: The cabinet is offline.
<  Enable the Light Up Slowly Function

Set the Light up slowly switchto ®) so that after the screen is powered on, the display brightness will

slowly change from 0 to the target value.
4  Set Test Pattern

Select a test pattern from the drop -down list of Test Pattern to perform screen aging test and troublesho ot
problems.

4  Set Image for Abnormal Situations
Select an option from the No data signal drop -down list.

Blackout: The screen displays a black image.

Last Frame: The screen always displays the last frame.

5.5 Set OPT Ports

Applicable Products

MX40 Pro

Operating Procedure

Step 1 Select a screen from the project list and then select Layout .

Step 2 Set the output mode of the OPT ports under OPT Settings. You can choose either 20 Ports Mode or 40 Ports
Mode.
20- port mode:
OPT 1 transmits the data of Ethernet ports 1 to 10. OPT 3 is the copy channel of OPT 1.
OPT 2 transmits the data of Ethernet ports 11 to 20. OPT 4 is the copy channel of OPT 2.

You can use the optical port alongside the physical Ethernet port, with priority given in the following
order: OPT 1/2 > OPT 3/4 > Ethernet ports 1  20.

. 40-port mode:
OPT 1 transmits the data of Ethernet ports 1 to 10.
OPT 2 transmits the data of Ethernet ports 11 to 20.

OPT 3 transmits the data of Ethernet ports 21 to 30.
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OPT 4 transmits the data of Ethernet ports 31 to 40.

You can use the optical port alongside the physical Ethernet port, with priority given in the following
order: OPT 1/2 > Ethernet ports 1 20.

Figure 5- 10 OPT settings

OPT Settings

@ 20 Ports Mode
OPT 1=0PT 3 * (Port 1-100
OPT 2=0PT 4 + (Port 11-20)
40 Ports Mode
OPT 1 : (Port 1-10y
OPT 2 * (Port 11-20)
OPT3 + (Port 21-30)
OPT 4 * (Port 31-40)

BiNote

When both the optical and Ethernet ports are used simultaneously, please do NOT connect the controller's
Ethernet port with the same number as the one of the optical port to the receiving card at the same time. If
they are connected simultaneously, the display effect of the optical port will take precedence.

When Ethernet port backup is enabled in 40 -port mode, t he last 20 Ethernet ports are backed up by the
first 20 Ethernet ports. When switching to the 20 - port mode, please remember to remove the loop backup
setup of the receiving card.

While in the 40 - port mode, additional Ethernet ports can be used to create ea sier screen topology without
reducing the controller's maximum load capacity.
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6 Input Source Configuration

6.1 Set Layers

Add layers and set the layer properties.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Prerequisites

For single- card controllers (MX40 Pro, MX30, MX20, KU20 , CX40 Pro), the Layers function is only available while
under All- In- One Controller mode. Please refer to 5.1 Edit Screens for more details.

For card-based controllers (MX6000 Pro and MX2000 Pro), the Layers function is available for both All - In-

One Controller and Send - Only Controller modes.
All- In- One Controller supports free layer layout.

Send- Only Controller follows a fixed layer layout with a predetermined layer quantity.

Related Information

The maximum number of layers that can be added depends on the connected controller. When the supported
layer quantity is 1, layer position, border, input crop and other operations are not supported.

Controller Model Number of Supported Layers

MX40 Pro 4

MX30 3

MX20 3

KU20 1

CX40 Pro 3

MX6000 Pro (Each input card supports 4 layers, and up to 8 input cards can be used at the
same time.)

MX2000 Pro (Each input card supports 4 layers, and up to 2 input cards can be used at the
same time.)

Operating Procedure

Step 1 Select a controller from the project list and then select Source.

www.novastar.tech PAGE ]



VMP Vision Management
Platform User Manual

Figure 6-1 Input source

offline Project +

New Project 1

Switch Source

Position and Size

Step 2 Select an input card at the bottom of the page when there are multiple input cards.
Step 3 Double-click the thumbnail of the input source or drag the input source to the ta  rget position to add a layer.

You can check the source status according to the source indicator:
Green: The input source is connected.
Red: The input source is being used for the screen but not connected.

Gray: The input source is not connected.
Step 4 Make layer adjustments as needed.

4 Lock layer

4 Switch source
Select a layer and select another source in the properties area.

Switch Source

Internal

Right- click a layer, select Source from the displayed menu, and select another source.
4 Adjust layer size and position

Select a layer and set the layer size and coordinates in the properties area. You can also bring the layer
to front or send it to back.
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Position and Size

Right- click a layer and select Bring to Front , Send to Back , Bring Forward or Send Backward from the
displayed menu.

At the top right of a layer, click a function icon to set the layer.

E: Lock the layer.

m: Unlock the layer.
1:1 17N layer size is the same as the input source resolution.

LA The layer automatically fill the screen.

rA
: The layer size changes automatically according to the canvas size.
: Delete the layer.

4  Set borders

Select a layer and enable or disable the layer borders function in the properties area. After enabling the
function, you can set the border thickness and color.

Border

Thick

4 Crop the input source

Select a layer and enable or disable the Crop function in the properties area. Then, you can set the crop size
and position on the thumbnail of the layer. You can also make adjustments by setting the parameter values
below the thumbnail. When Same as Layer Size is set to @0 thein put source image will be cropped

according to the layer size.
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6.2 Set External Sources

Select a controller from the project list and then select  Source. Select an external source from the source list and

do the following as requir ed.

6.2.1 Set Connector Capacity

When installing an 8K input card in a card -based controller, it is necessary to configure the connector capacity

for the input source in order to calculate the layer resources of the input  connectors.

Applicable Products

MX6000 Pro, MX2000 Pro

Operating Procedure

Select an option from the drop -down list and the system will automatically calculate the layer resources. Below
takes the MX_2xDP1.4 input card as an e xample.

4096*2160@60Hz: Up to 4 layers can be added.

8192*2160@60Hz: The maximum number of layers that can be added is determined based on the size of the

input source used in the currently enabled layers of the input card. For example:
efLZ UP§Z6 TNDB S§ZNOT PBHUOILP BO A

WhLZ OP8§26 BZL 8ZNOT PHUOIL BO A EZk
maximum of three layers can be added.

Figure 6-2 Connector capacity

Connector Capacity

DPL4 4096*2160@60Hz
4096*2160@60Hz

6.2.2 Set Resolution and Refresh Rate

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Related Information

If the resolutions of the input source and screen are the same, the image can be displayed pixel to pixel.

A lower frame rate may result in image flickering, while a higher refresh rate helps stabilize the display image.

Operating Pr ocedure

Select a value from the drop -down lists of Resolution and Refresh Rate and click Apply .
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Figure 6-3 EDID

384072160

Frame Rate 60.00Hz

6.2.3 Adjust the Color

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Operating Procedure

Step 1 Inthe InfoFrame Override area, select a value from the drop - down lists of Color Space/Sampling , Gamut and

Quantization Range .
The override parameter will be used in the calculation of color adjustment. Select  From Input and the software

will read the attribute value that comes wi th the input source.

Figure 6-4 InfoFrame override

InfoFrame Override

pling YCbCr 4:2:0

Rec.709

From Input

Binote

When selecting the color space/sampling as YCbCr 4:2:0, the input source resolution’ s height must be an even

number, and the width must be a multiple of 8.

Step 2 Inthe Color area, drag the sliders to adjust the parameter values.
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Table 6- 1 Descriptions of color adjustment parameters

Parameter Description

Black Level It is used to adjust the brightness of the dark areas of the image. The smaller the
value, the darker the dark part of the screen.

Contrast It is used to adjust the brightness of the highlight areas of the image. The greater
the value, the brighter the highlight part of the screen.
Contrast and black level together affect the overall contrast of the image.

Saturation It is used to adjust the color purity of the image. The greater the value, the more
vivid the color.

Hue It is used to adjust the color effect of the displayed image color. Generally, it is

divided into warm, cool and intermediate tones.

Red Shadow/Green
Shadow/Blue Shadow

It is used to adjust the brightness of the dark areas of the image. The principle is

the same as that of black level, but only the RGB components are adjusted.

Red Highlight/Green
Highlight/Blue Highlight

It is used to adju st the brightness of the highlight areas of the image. The principle

is the same as that of contrast, but the RGB components are adjusted.

6.2.4 Set HDR Parameters

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, CX40 Pro
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Related Information

Supports automatic parsing and manual setting of HDR. For 12G -SDI, DP1.2, and non standard HDR sources,
they can only be set to HDR properties manually.

Using the HDR function together with receiving cards including the CA50E , XA50 Pro, and A10s Pro and its
derivatives will not reduce the Ethernet port load capacity by half. For details, see the COEX series LED display
controller specifications.

Operating Procedure

Select an HDR format from the drop -down list of Format and set related parameters. Select Auto and the
software will read the attribute value that comes with the input source.

Figure 6-6 HDR

ST2084 (PQ)

Override

1000nits |5

HDR10 parameters:
PQ Mode: The mapping method of video source brightness.

ST2084 (PQ): This mode 1:1 maps the brightness of the video source. The part that exceeds the
maximum screen brightness will still be displayed as the maximum screen brightness.

ST2086 (Linear mapping): This mode linearly maps the brightness of the video source. It globally adjust
the video source brightness according to the maximum screen brightne  ss to ensure that the ratio of the

brightness of the entire source content remains unchanged.

MaxCLL: The override value of the maximum video source brightness. MaxCLL takes effect when Override is
selected.

E Note

When HDR is enabled, the gamma value canno t be adjusted. In PQ mode, if HDR 2084 is selected, brightness
adjustment is also not supported.

HDR 2084 and brightness schedule cannot be enabled at the same time. If HDR 2084 is selected while the

brightness schedule is already enabled, the brightness s chedule will take precedence.

6.2.5 Set ST 2110 Parameters

When installing ST 2110 input cards in card -based controllers like the MX6000 Pro and MX2000 Pro, you need to
configure the relevant parameters .

www.novastar.tech PAGE ez



Applicable Products

MX6000 Pro, MX2000 Pro

Operating Proce dure

Step 1 Select the ST 2110 input card from the source list and navigate to the
the right.

Figure 6-7 ST 2110 settings

Tools  Settings  Help

= Correction Processing  Screen Seftings
& Blackout © = 9

% Freeze 5 G HHH

MX6000 Pro_1-OUT 1

Step2 Whenus8 26 TFL yi AE  card, you need to cénfiguie thiNdiahnel in the

area.
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ST 2110 Settings in the properties area on

Monitor Schedule
=

@) @ Page1 v

Adjust Input Source

Video Stream

Primary OPT

Backup OPT

NMOS Settings

rol In

Primary OPT

btain Automatically

Backup OPT

7072 OLPByoOTEhzZ OBO E Ps§Z4Gyl
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239.0.2020
5004

0.0.00

239.0.2021
5004
0.0.00

3840°2160
60Hz
YCber 4:2:2
10bit

it ) éport SD}

ST2110SFP 1

mDNS

I r

Step 3 Under the Video Stream section, you can set the ST 2110 port information using either of the following two

methods.

Method 1: Click to load the SDP file for configuration.

Method 2: Click Edit and fill in the below parameters to complete the OPT configuration. Once the setup

complete, you can export the current parameters as an SDP file.
Destination IP (primary/backup OPT ports)
Port (primary/backup OPT ports)

Source IP (primary/backup OPT ports)
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Select an option from the drop -down lists of Resolution , Refresh Rate , Color Space/Sampling , and Bit

Depth . You can also set a custom resolution.
Step 4 Inthe NMOS Settings section, set the NMOS control interface and registry mode, then click Apply .

Control Interface: Options include ETHERNET or ST 2110 SFP1.

Registry Mode: Options includ e mDNS, DNS SD, and Static.

Figure 6-8 NMOS

NMOS Settings

ST 2110 5FP 1

mDNS

(apply )

Step 5 Set the primary and backup OPT IP addresses for the ST 2110 input card under the Primary OPT IP and Backup
OPT IP sections.

You can enter the IP address manually or simply toggle on Obtain Automatically . Remember to click Apply once
you are done.

E Notes

Please assign different subnet IP addresses to the optical ports on the ST 2110 card. Failure to do so may result in
NMOS malfunctions due to network card routing issues.

Example: (SFP1: 192.168.0.20, SFP2: 192.168.1.20).

Step 6 Configure the input source synchronization under the  PTP section.

1. Enable or disable Input is Locked to PTP . Enabling this option allows for high - precision synchronization with
the network's primary clock.

2. Configure the PTP parameters, including Domain, Log sync interval , and Log delay request interval

3. Review the PTP status, which includes the Master Clock MAC , Time Lock Status , and Offset from Leader

B Note

If the Time Lock Status shows Unlocked , enabling Input is Locked to PTP may result in display abnormalities.

4. Remember to click Apply once you are done.
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Figure 6-9 PTP

h's

Follower

Unlocked

(apply )

Step 7 Adjust the on/off status for FEC Settings .

Enabling this feature allows for automatic error detection and correction during data transmission, enhancing the

reliability of video signal transmission.

E Note

Only supported by the MX_1 xST 2110 (25G)and MX_1xST 2110 (100G) input cards.

The FEC feature must be configured on the switch before it can be used.

Figure 6- 10 FEC settings

FEC Settings

Status

Step 8 Review the IGMP multicast protocol version.
6.3 Set Internal Sources
Select the internal source and set the related parameters for screen testing and troubleshooting.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Operating Procedure

Step 1 Select a controller from the project list and then select  Source.

Step 2 Double-click the thumbnail of internal source in the source list at the bottom of the page, or select

Source from the drop -down list nextto Select Source in the properties area on the right.

Internal

Step 3 Select an image and set the Grayscale, Gradient Stretch , Speed, and Space. The adjustable parameters for each

image may vary based on the interface.

Static images
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These images come with VMP, as shown in the figure below.

Dynamic images

These images come with VMP, as shown in the figure below.

Gradient Stretch

Speed

Step 4 Set the resolution, frame rate and bit depth for the internal source.

Resolution 38402160

Refresh Rate 60.00Hz

Bit Depth Bbit

Step 5 After the settings, click Apply .
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7 Display Correction
This chapter describes output configuration with one  device selected.

7.1 Seams

7.1.1 Correct Seams

Adjust the seams between cabinets or modules to improve the display effect.

Related Information

If brightness correction has been done for the screen, the screen brightness can be adjusted in nits. Otherwise, it

can be adjusted only in percentage.

Operating Procedure

Step 1 Select a screen from the project list and then select Correction .

Step 2 Onthe Seamstab in the properties area, toggle onthe Seam Correction (#L).

E Note

Currently, apart from the A10s Pro receiving card and its derivatives, the ~ Seam Correction switch will not be
displayed on this interface. In such case, simply toggling on the Brightness Calibration or Brightness and
Chroma Calibration will ensure that the seam correction takes effect.

Step 3 Toggle on Brightness Calibration or Brightness and Chroma Calibration  to view the correction effect.
Brightness Calibration: Set the Brightness Calibration switch to @0 to make the screen apply the calibration
effect made by t he calibration platform.

Brightness and Chroma Calibration: Set the Brightness and Chroma Calibration  switch to @0 to make the

screen apply the calibration effect made by the calibration platform.

The Brightness Calibration and Brightness and Chroma Calibra tion are mutually exclusive.

Figure 7-1 Correction (seams)

Seams

Seam Correction

v Correction

Brightness Calibration ]
[

Brightness and Chroma Calibration

Step 4 Select a correction mode.
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Step 6

Step 7

Step 8
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Figure 7-2 Select mode (seams)

v Select Mode

Cabinet Seams

Cabinet Seams: Correct the seams of cabinets.
LDM Seams: Correct the seams of modules.
When correcting the module seams, if you need to override the numbers of module columns and rows, click the

“ icon next to Select Mode and then perform the settings on the Cabinet Structure Override  window.

Otherwise, skip this step.

Figure 7-3 Cabinet structure over ride

Cabinet Structure Override

Cabinet Structure Override

1

-
-
-
-

Set the screen display parameters and check the seam correction effect.

Figure 7-4 Adjustment (7 - color/4 - color)

Adjustment

Adjustment

126nits Brightn

Brightness: Adjust the display brightness.

Display image: Set the image displayed on the screen. By default, the current input source is being  displayed
(N). You can switch to a monochrome display. The available colors depend on the model and version of the
receiving card in use. Additionally, you can use the corresponding shortcut keys to switch between display

modes.

E Note

You can only configur e the displayed image for the currently selected page. All other pages will show a black

screen.

In the topology area, click or click and drag the mouse to select the seams to be corrected.

Set the adjustment parameters.
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Figure 7-5 Set the parameters

® Quick adjust

Fine adjust

Hide the

Quick adjust: Has a large range of adjustment.
Fine Adjust: Has a large range of adjustment.

Hide cursor on screen: When this is enabled ( #0)), the cursor will not be displayed on the screen while adjusting

brightness and chroma.

Step 9 Place the mouse on the scroll wheel icon a nd adjust the brightness by dragging the wheel icon up or down,
scrolling the mouse wheel, or using the keyboard shortcuts 1+ /

Restore: Restore the configuration to the last saved.

Reset: Reset the configuration to factory defaults.

Step 10 After the settings, click Save.

7.1.2 Erase Seam Correction

Related Information

If there are any changes made to the cabinets, such as moving a receiving card from one cabinet to another or
replacing the cabinet module, it may cause bright or dark lines that had been previously cor  rected to appear in
the middle of the cabinet or module. In such cases, you have the option to remove the seam correction that was

applied.

Operating Procedure

Step 1 Select a screen from the project list and then select Correction .

Step 2 Select the Cabinet mode.

Figure 7-6 Select mode (cabinet)

v Select Mode

LDM Seams Cabinet
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Step 3 Select the target cabinets and then click Erase to remove the seam correction that was applied to them. The

erasion will be automatically saved to the hardware once you are done.

Figure 7-7 Erase seam correction

* Correction

v Select Mode

7.2 Correct Multi - Batch Cabinets/Modules

Adjust the chroma of cabinets or modules from multiple batches to make the overall chroma of the display more
balanced and uniform.

Applicable Products

The adjustable range varies depending on the model and version of the receiving card.

7- color multi - batch adjustment: Supported by XA50 Pro, CA50E,A10s Pro and its derivatives (version V1.5 .3.0

and above).

4- color multi - batch adjustment: Supported by A5s Plus, A7s Plus, A8s -N, A8s Pro and its derivatives, and B6s

(version V1.3.0.0 and above).

Related Information

When performing the adjustments, note that the 7 - color multi - batch adjustment uses an independent matrix
adjustment and will not affect the calibration coefficients. In contrast, the 4 - color multi - batch adjustment is

coupled with the calibration coefficients, and adjustments may slightly influence these coefficients.

If brightness correction has been done for the screen, the screen brightness can be adjusted in nits. Otherwise, it

can be adjusted only in percentage.

7-color Multi - batc h Adjustment

Step 1 Select a screen from the project list and then select Correction .
Step 2 On the Modules tab in the properties area, toggle on  Multi - batch (D).

Step 3 Toggle on Brightness Calibration or Brightness and Chroma Calibration  to view the correction effect.
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Brightness Calibration: Set the Brightness Calibration switch to ® to make the screen apply the calibration
effect made by the calibration platform.

Brightness and Chroma Calibration: Set the Brightness and Chroma Calibration ~ switchto ®) to make the
screen apply the calibration effect made by the calibration platform.

Figure 7-8 Correction (modules)

Seams

seam Correction

Correction

Step 4 Select a correction mode.

Figure 7-9 Select mode (modules)

v Select Mode

Cabinet LDM
| |

Cabinet: Correct the multi -batch cabinets.

Module: Correct the multi -batch modules.

Step 5 When correcting multi - batch modules, if you need to override the numbers of module columns and rows, click the

“ icon next to Select Mode and then perform the settings on the Cabinet Structure Override  window.
Otherwise, skip this step.

Figure 7- 10 Cabinet structure override

Cabinet Structure Override

Cabinet Structure Override

| Cancel |

Step 6 Set the screen display pa rameters and check the display effect.
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Figure 7-11 Adjustment (modules)

Adjustment

12é6nits

Brightness: Adjust the display brightness.

Display image: Set the image displayed on the screen. By default, the current input source is being displayed
(N). You can switch to a monochrome display in white, red, green, blue, cyan, magenta and yellow. To do so,

simply press the shortcut keys W, R, G, B, C, M, Y, and Tab.

E Note

You can only configure the displayed image for the currently selected page. All other pages will show a black

screen.

Step 7 In the topology area, click or click and drag the mouse to select the cabinets or modules to be corrected.

Step 8 Adjust the parameters. Different colors have different adjustment parameters. Place the mouse on the scroll

wheel icon and adjust the brightness by dragging the wheel icon up or down, scrolling the mouse wheel, or using

the keyboard shortcuts 1+ /

Figure 7- 12 Adjustment (White/Red/Blue/Green/Cyan/Magenta/Yellow)
Adjustment

Brightness

W) (R G (B © M M (Tab)

Hide the cursor while adjusting

Restore: Restore the configuration for the current color to the last saved.

. Restore All: Restore the configuration for all colors to the last saved.
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Restore to Last Saved: Restore the configuration to the last saved.

Hide cursor on screen: When this is enabled ( #)), the cursor will not be displayed on the screen while adjusting

brightness and chroma.

Import Coefs: Import the existing correction coefficients to the current cabinet/module.

Export Coefs: Export the correction coefficients of the current cabinet/module.

Once a cabinet's parameters are set, you can right - click to copy the current cabinet's pa rameters and paste them

to other cabinets. Alternatively, use the shortcuts Ctrl +C to copy and Citrl +V to paste.

Step 9 Click Save once you are done to save the configuration to the receiving card.

4- color Multi - batch Adjustment

Step 1 Select a screen from the project list and then select Correction .

Step 2 On the Modules tab in the properties area, you can enable the correction switches including  Brightness

Calibration and Brightness and Chroma Calibration  to view the correction effect.
Bright ness Calibration: Set the Brightness Calibration switch to ®) to make the screen apply the calibration
effect made by the calibration platform.

Brightness and Chroma Calibration: Set the Brightness and Chroma Calibration ~ switchto ®_) to make the

screen apply the calibration effect made by the calibration platform.

The Brightness Calibration and Brightness and Chroma Calibration  are mutually exclusive.

Figure 7-13 Correction (modules)

ns Modules

v Correction

Brightness Calibration

Brightness and Chroma Calibration

Step 3 Select a correction mode.

Figure 7-14 Select mode (modules)

v Select Mode

Cabinet LDM
| |

Cabinet: Correct the multi -batch cabinets.

. Module: Correct the multi -batch modules.

Step 4 When correcting multi - batch modules, if you need to override the numbers of module columns and rows, click the
“ icon next to Select Mode and then perform the settings on the Cabinet Structure Override  window.

Otherwise, skip this step.
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Figure 7-15 Cabinet structure override

Cabinet Structure Override

Cabinet Structure Override

Step 5 Set the screen display parameters and check the display effect.

Figure 7-16 Screen Control

Adjustment

Brightness: Adjust the display brightness.

Display image: Set the image displayed on the screen. By default, the current input source is being displayed.
You can switch to a monochrome display in white, red, green, and blue.

To do so, simply press the shortcut keys W, R, G, B, and Tab.

E Note

You can only configure the displayed image for the currently selected page.  All other pages will show a black

screen.

Step 6 In the topology area, click or click and drag the mouse to select the cabinets or modules to be corrected.

Step 7 Adjust the parameters. Different colors have different adjustment parameters. Place the mouse on the scroll
wheel icon and adjust the brightness by dragging the wheel icon up or down, scrolling the mouse wheel, or using

the keyboard shortcuts 1+ /
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Figure 7-17 Adjustment (White/Red/Blue/Green)

Adjustment

-

100.0% |2

Hide the

Restore to Last Saved: Restore the configuration to the last saved.

Hide cursor on screen: When this is enabled ( #0), the cursor will not be displayed on the screen while adjusting
brightness and chroma.

Import Coefs: Import th e existing correction coefficients to the current cabinet/module.
Export Coefs: Export the correction coefficients of the current cabinet/module.
Once a cabinet's parameters are set, you can right -click to copy the current cabinet's parameters and paste th em

to other cabinets. Alternatively, use the shortcuts Ctrl +C to copy and Ctrl +V to paste.

Step 8 Click Save once you are done to save the configuration to the receiving card.
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8 Color Processing

This chapter describes output configuration with one device selected.

8.1 Color Replacement

Replace a color with another color according to the settings.

Applicable Products

Notice

MX6000 Pro, MX2000 Pro, MX40 Pro, CX40 Pro

Replacement of highly saturated colors is recommended for better  effect.

Operating Procedure

Step 1
Step 2

Step 3

Step 4

B

Select a screen from the project list and then select Processing .
Set the Color Replacement switch to @0,
Set the colors before and after replacement.

Method 1: Click the color area in to open the color palette and set a color.

Method 2: Click the eyedropper in and select a color in the topology area.

Figure 8-1 Color replacement

+ Color Replacement ¥

From f
Hue Tolerance

Hue Softness

Shadow Strength

Skin tone Protect

Set Hue Tolerance , Hue Softness , Shadow Strength , and Skin Tone Protect .

Hue Tolerance: Indicates the hue range of the color to be replaced. The larger the  value, the larger the
replacement area

Hue Softness: Indicates the hue softness of the transition area.

Shadow Strength: Indicates the gradient parameter of the highlight or shadow area. The larger the value, the

smoother the gradient.

Skin Tone Protect: Keeps the skin tone as original as possible.
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8.2 14Ch Color Correction

Precisely adjust the hue, saturation and brightness of black, white, and the 12 derived standard colors of the red,
green and blue primary colors.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, CX40 Pro

Operating Procedure

Step 1 Select a screen from the project list and then select Processing .
Step 2 Set the 14h Color Correction switch to ®0.

Step 3 Click a value of a color to enable the editing status and change the value.

Parameter Change Trend

Positive value: The hue angle changes counterclockwise.
Hue (H)

Negative value: The hue angle changes clockwise.

Decrease to - 100%: The 12 colors are gradually diluted.
Saturation (S)

Increase to +100%: The 12 colors are more vivid and rich.

Decrease to - 100%: The 12 colors gradually darken.

Brightness (B) Increase to +100%: The 12 colors are brighter, and the colors seems to be

diluted.

Figure 8-2 14Ch color correction

» 14Ch Color Correction ¥

H()

™ Il White

Black
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8.3 Set Color Curves

This feature allows you to quickly adjust image brightness and  color tone, customize the response curves for red,
green, blue, and white, and fine -tune highlights and shadows independently. It ensures that highlights are not
overexposed and that low -grey areas retain rich details. Additionally, you can use this featur e to make precise

tweaks to the screen display, compensating for variations due to ambient light or camera performance.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, CX40 Pro

Operating Procedure

Step 1 Select a screen from the project list and then select Processing .

Step 2 Setthe Curve switchto @0,

Figure 8-3 Curves

v Curves ¥

W R

Output

166

Step 3 (Optional) Click H to enter full - screen mode. This will expand the curve adjustment section to the center of
the screen, making it easier to fine -tune details.

www.novastar.tech PAGE =l



VMP Vision Management
Platform User Manual

Step 4 Select the white, red, green or blue channel.
Step 5 Drag the slider at the bottom of the curve diagram to set the curve adjustment range.
Step 6 Click anywhere on the curve to add an adjustment point and drag the point to adjust the curve.

Input and Output indicate the absolute coordinates of the adjustment point  in the curve diagram.
To delete the adjustment point, drag the point outside the curve diagram, or select the point and press Delete .

Click the icon at the right of Channel to reset the curve of the current channel. Click the icon next to
Curves to reset all the curves.

8.4 Enable 3D LUT

A set of mapping relationships are defined in the 3D LUT file (.cube) to adjust the colors of the video source. It is
commonly used in the film and image processing industries. With this feature, you can change target colo  rs
without affecting neutral gray and other colors, which eliminates the issue of layer merging and maintains
smooth color transitions. Additionally, this feature provides precise control over the entire color space, offering
more accurate colors and enhan cing the overall effect.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, CX40 Pro

Prerequisites

Please prepare a 3D LUT file in the .cube format with a file precision of either 17 17 17,33 33 33,0r 65 65 65.

Operating Procedure

Step 1 Select a screen from the project list and then select Processing .

Step 2 Click anywhere in the Load 3DLUT File area, select a file and open it.
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Figure 8-4 Loading 3D LUT file

v 3D LUT

Step 3 Setthe 3D LUT to ®) and drag the slider to adjust the strength of the 3D LUT.

Figure 8-5 Adjusting intensity
v 3D LUT

NightFromDay CUBE
Night from Day

Intensity @

To delete the file, click .

8.5 Enable Dynamic Booster

Dynamic Booster can significantly improve the display contrast and image details for better visual experience and
effectively control and lower the display power consumption.

Applicable Products

LED display controllers: MX40 Pro, CX40 Pro

Receiving cards: XA50 Pro, CA50E, A10s Pro and its derivatives.

Prerequisites

Before the operation, color gamut and brightness correction by using the CA410 -VP427, CA410-P427 or CA410-
P427H colorimeter must be done. Ot herwise, the Dynamic Booster switch is grayed out and the function is

unavailable.

Operating Procedure

Step 1 Select a screen from the project list and then select Processing .
Step 2 Set the Dynamic Booster switch to ®0).

Step 3 Drag the slider to adjust the intensity of applying the Dynamic Booster.

Figure 8-6 Dynamic Booster

» Dynamic Booster

Level

www.novastar.tech PAGE v



VMP Vision Management
Platform User Manual

9 Screen Settings

9.1 Adjust Image Quality

9.1.1 Adjustment Mode

Switch the cabinet display mode to let the screen of the same specifications have the optimal display effect under

different app lication scenarios.

Prerequisites

The NCP file is uploaded, and the NCP files of the receiving card and the controller must match. For details, see

16.2 Manage Cabinet Library .

Operating Procedure

Step 1 Select a screen from the project list and then select Screen Settings .

Step 2 On the Image Quality tab, select a mode based on the application scenario to let the screen have th e optimal

display effect.

Support mode switching when using different sizes of cabinets of the same batch with different specifications

under a single Ethernet port.

Figure 9-1 Mode

Image Quality

Mode Model

9.1.2 Adjust Brightness and Gamma

Manually adjust the screen brightness, gamma, and brightness components to change the brightness
performance of the display in real -time. You can also set the maximum brightness as needed and toggle

Brightness Overdrive on or off.

Prerequisites

To use the brightness overdrive function, please make sure the NCP file is uploaded, and the NCP files of the

receiving card and the controller must match. For details, see 16.2 Manage Cabinet Library .

Related Information

If brightness correction has been done for the screen, the screen brightness can be adjusted in nits. Otherwise, it

can be adjusted only in percentage.
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Operating Procedure

Step 1 Select a screen from the project list and then select Screen Settings .

Step 2 On the Image Quality tab, click n to open the pop -up window. Here, you can enable or disable the Brightness

Limit and set the limit value.

Figure 9- 2 Brightness limit

Brightness Limit

Limit

Step 3 Enable or disable Brightness Overdrive based on on-site needs.

After calibration, some brightnes s is usually lost. By enabling Brightness Overdrive, the screen's brightness can be
restored to its pre - calibration levels. If higher brightness is desired for improved HDR effects, this feature can

compensate for the lost brightness, making specific content like starry skies appear especially bright.

Step 4 Adjust the values for brightness, gamma, and the RGBW brightness components.
Only receiving cards such as XA50 Pro, CA50E, A10s Pro and its derivatives (version V1.5 .3.0 and later) sup port

RGBW component adjustment.

Figure 9- 3 Adjustment

Adjustment

9.1.3 Set LED Image Booster

Set the LED Image Booster function to improve the delicacy and accuracy of the image color and gradation and

realize free switching of the display color gamut.

Applicable Products

LED display controllers: MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

B

Receiving cards: A10s Pro and its derivatives, A8s, A8s-N, XA50 Pro, CA50E
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www.novastar.tech



VMP Vision Management
Platform User Manual

Prerequisites

Before the operation, color gamut and brightness correction by using the CA410 -VP427, CA410-P427 or CA410-

P427H colorimeter must be done.

Operating Procedure

Step 1 Select a screen from the project list and then select Screen Settings .

Step 2 Select the Image Quality tab onthe Screen Settings page. In the LED Image Booster area on the right, select an
output color gamut from the  Gamut drop -down list.

The output gamut options include standard gamuts, custom gamuts, the original screen gamut and the input

gamut ( From input ).

To set the custom gamut, click - select a gamut in the properties area on the color gamut diagram, and adjust
the red, green, blue and white parameters based ont he selected gamut. The custom gamut name can be
changed.

Step 3 Drag the slider to adjust color temperature.

Step 4 Enable or disable Magic Gray as needed.

Figure 9-4 LED Image Booster
LED Image Booster

Original

a

® 15000k |5
o

9.1.4 Set Thermal Compensation

Adjust the application intensity of the thermal coefficients.

Applic able Products

LED display controllers: MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Receiving cards: A10s Pro and its derivatives, A8s, A8s-N, XA50 Pro, CA50E

Prerequisites

Before operation, it is necessary to complete the thermal calibration of the screen. Use the Cabinet Tool to create
an NCP file containing the rmal coefficients and upload it . The thermal compensation interface ma y vary

depending on the receiving card model and the settings in the NCP file.

Operating Procedure

Step 1 Select a screen from the project list and then select Screen Settings .
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Step 2 Onthe Image Quality tab, setthe Thermal Compensation switchto 0.

Figure 9-5 Thermal Compensation - Auto/Manual

* Thermal Compensation

Adjust Mode Auto

Strength Auto
[ ] Manual

Step 3 Adjust the thermal compensation coefficient using  either manual or automatic mod e.

Automatic: The system automatically generates the thermal coefficient application strength based on the screen

status, eliminating the need for manual adjustments.

Manual: Adjust the application strength of the thermal coefficient by dragging the slider

9.1.5 Adjust EOTF

Applicable Products

LED display controllers: MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Receiving cards: A10s Pro and its derivatives, A8s, A8s-N, XA50 Pro, CA50E

Related Information

The supported adjustment parameters depen d on the HDR settings.

Operating Procedure

Step 1 Select a screen from the project list and then select Screen Settings .

Step 2 Inthe Image Quality tab, drag the sliders to adjust the values of Shadow Compensation , Ambient Light

Compensation and Clip Level .

Figure 9-6 EOTFadjustment

v EOTF Adjustment ¥

Shadow Compensation
@

Ambient Light Compensation

9.2 Set Output

9.2.1 Set Video Parameters

Set the output bit depth and additional frame latency.
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Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20 (output bit depth is fixed at 8 - bit), CX40 Pro

Operating Procedure

Step 1 Select a screen from the project list and then select Screen Settings .
Step 2 In the Output tab, select an option from the drop - down list of Bit Depth .

If Auto is selected, the output bit depth is the same as the input bit depth.

Figure 9-7 Output bit depth

Qutput

+* Video

Bit Depth Auto

Additional Frame Latency Off

Step 3 Set a value for Additional Frame Latency

When the controller works with high - latency devices, you can set additional frame latency.

E Note

It is not possible to set Additional Frame Latency when Low Latency is enabled.

9.2.2 Set Sync Parameters

Set the sync source and phase offset.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Operating Procedure

Step 1 Select a screen from the project list and then select Screen Settings .
Step 2 Select the Output tab.

Step 3 Select a synchronization signal for the display frame rate and set the phase offset.

Figure 9-8 Sync

60.00Hz

Internal(60.00Hz)

Genlock Not locked
Internal 60.00Hz

Phase Offset Off
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Canvas Max Frame Rate: This displays the maximum frame rate of the current output card's canvas. If all

canvases have the same maximum frame rate, it will show the value. If the frame rates are different, it will disp  lay
Mix.

Source: Sync with the frame rate of the active source.

Genlock: Sync with the frame rate of the Genlock signal. When the shutter fit function of the controller is

effective, please select this option. In addition, the controller and the camera nee  d to use the same Genlock

signal generator.

Internal: Sync with the frame rate of the controller's internal clock.

E Note

When low latency is enabled, setting the sync source to Genlock and adjusting phase offset are not

supported.

The Genlock parameter adj ustment only takes effect on the selected controller, while other output

adjustments applies to all controllers of the screen.

9.2.3 Set Frame Multiplication

Frame multiplication can make the screen output multiple frames within the original one frame time and p rovide

them to different cameras.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, CX40 Pro

Related Information

Frame multiplication, low latency, and 3D cannot be enabled at the same time.

MX6000 Pro and MX2000 Pro are capable of supporting a max frame rate of 480 Hz when using the XA50 Pro,

CAB50E, and A10s Pro and its derivatives receiving cards.

MX40 Pro is capable of supporting a max frame rate of 240 Hz when using the A10s Pro and its derivatives

receiving cards.

CX40 Pro is capable of supporti ng a max frame rate of 240 Hz when using the XA50 Pro and CA50E receiving

cards.

The specific maximum frame rate that can be set is related to the hardware configuration of the screen.

Operating Procedure

Step 1 Select a screen from the project list and then select Screen Settings .

Step 2 Select the Output tab and set Frame Multiplication to &O.
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Figure 9-9 Frame multiplication

v Frame Multiplication

Frame Multiplication 3 (179.82Hz)
Output Frames

1 Video v Offset X 0

2 Video v ¥ 19205 ¥

Color

Step 3 Set the number of frames and the display mode of each frame.

Take the above figure as an example. The par ameters are described as follows:

Frame Multiplication: After the current frame rate (59.94) is multiplied by 3, it is 179.82 Hz. Three frames are
output in 1/59.94 second.

Video: The first and second frames display the input source image. The first frame  displays the image from the
coordinates (0, 0) and the second frame displays the image from the coordinates (1920, 0).

Color: The third frame displays a pure white image.

9.2.4 Set Shutter Fit

Adapt the screen and camera shutter to produce better filming results

Applicable Products

LED display controllers: MX6000 Pro, MX2000 Pro, MX40 Pro, CX40 Pro

Receiving cards: XA50 Pro, CA50E, A10s Pro and its derivatives.

Prerequisites

It requires that the sync signal must be Genlock and the controller and camera needto  use the same Genlock
signal generator.

Operating Procedure

Step 1 Select a screen from the project list and then select Screen Settings .

Step 2 Select the Output tab and set Shutter Fit to &O.

Figure 9- 10 Shutter fit

» Shutter Fit

Mode Angle

90.000°

Step 3 Set the relevant parameters.
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9.2.5 Enable 3D Function

Enable the 3D function and set the related parameters for users wearing 3D glasses to view stereoscopic images.

Applicable Products

LED display controllers: MX6000 Pro, MX2000 Pro, MX40 Pro, CX40 Pro

3D emitters: EMT200 Pro (5G/1G), EMT200 (1G)

Notice

The 3D function an d the low latency or frame multiplication function cannot be enabled at the same time.

Related Information

To use the 3D function, specified 3D glasses are needed. Please contact NovaStar technical support.

Operating Procedure

Step 1 Select a screen from the proj ect list and then select Screen Settings .

Step 2 Select the Output tab and set 3D to #0).

Figure 9-11 3D

* 3D
Source Format Side-by-Side

]

Eye Priority Left

3rd Emitter

Emitter Delay 7000us

Step 3 Set the parameters.

Source Format: Set the format of the 3D video source. Set the formatto  Side- by - side, Top-and-bottom or

Frame sequential according to the format of the accessed video source.

Right Eye Offset: Set the start position of the right eye image. When the video source format is side - by-side or

top - and- bottom and the left and right eye images are provided, this parameter can be set

Eye Priority: Set which image is sent first, the right eye image or the left eye image. Wear the 3D glasses to
watch the display. If the display is abnormal, set the parameter value to the other one. If the display is normal,

the setting is done.
. Custom Emitter: When a third - party 3D signal emitter is used, set the switchto ~ #0).

Emitter Delay: Set the delay time of sending the synchronization signal from the 3D signal emitter to the 3D
glasses. This setting ensures that the switching between left and right  eye images of the 3D glasses is in sync
with the switching between the left and right eye images on the display. This parameter is applicable to both the

NovaStar and third - party emitters.
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9.2.6 Enable SPDIF Audio

You can select one of the connected input sources for audio output.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Please note that some interfaces/input cards may not support SPDIF audio output on certain controllers. The

specifics are as follows:

Controller Interface/Input Card Audio Output
KU20 HDMI1.3 Supported
MX20 HDMI1.3 Supported
3G-SDI Not supported
MX30 HDMI2.0, HDMI 1.4, DP 1.1 Supported
3G-SDI Not supported
MX40 Pro HDMI 2.0_2, HDMI 2.0_3 Supported
HDMI 2.0_1, DP 1.2, 12G SDI Not supported
CX40 Pro HDMI 2.0_2 Supported
HDMI 2.0_1, DP 1.2, 12G SDI Not supported
MX6000 Pro, MX2000 Pro | 4 HDMI 2.0,4 DP 1.2, 2 HDMI 2.1, 2 Supported
DP 14,1 HDMI2.1+1 DP 14
1xDP 1.4 (8K@60 Hz), 4x12G SDI, Not supported
1xST 2110 (25G), ST 2110 (25G),
1xST 2110 (100G)

Operating Procedure

Step 1 Select a screen from the project list and then select Screen Settings .
Step 2 Select the Output tab and set Audio to ®0.

Step 3 Click the drop -down menu next to Input and select one of the connected input sources as output audio.

Figure 9-12 Audio

o v

Select an input

9.2.7 Check the Load

Check the capacity usage of each Ethernet port of the controller.
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Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Operating Procedure

Step 1 Select a screen from the project list and then select Screen Settings .

Step 2 Select the Output tab. Under Port Load , click . next to the controller information to check the usage of the

controller's load capacity.

Figure 9- 13 Port load

Port Load
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10 Backup Settings

10.1 Controller Backup

You can configure controller -level hot backup for controllers within the same screen, enabling the backup
controller to take over as the primary controller in case of a failure.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Prerequisites

A primary controll er can only have one backup controller.

The primary and backup controllers must be of the same model and firmware version. For card - cased controllers
(MX6000 Pro and MX2000 Pro), please also make sure the number, slot, model, and firmware version of the

daughter cards also match.

Controller backup and Ethernet port backup are mutually exclusive. You can only configure one type of backup
at a time. For card - cased controllers (MX6000 Pro and MX2000 Pro), controller backup, card backup, and
Ethernet port backu p are all mutually exclusive. However, controllers that have not been backed up support
simultaneous configuration of card backup and Ethernet port backup.

Related Information

Controller backup parameter synchronization :
1. When creating a controller backup, the backup controller will synchronize with the  primary controller's data.

2. Upon power cycling the primary /backup controller , it will sync data with the counterpart device.

E Note

If a controller goes offline and back online due to a disconnected Ethernet cable, the parameters will not be

synchronized between the controllers .

When controller backup is set up, only the primary controller can detect multifunction  card and light sensor
information. The backup controller does not support detecting or reading this information.

Operating Procedure

Step 1 Select a screen from the project list and then select Backup .
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Figure 10- 1 Controller backup

Backup Settings

Create Controller Backup

Step 2 All controllers of the screen will be shown in the canvas area . You can drag and drop a controller onto another to

establish a backup relationship.

The controller being dragged is considered the backup, while the one being dropped onto becomes the primary.
Upon dropping, a pop -up window will appear showing informatio n about the primary and backup controllers. If

everything is correct, simply click OK.
Step 3 Click Verify Primary or Verify Backup to examine whether the controllers are working properly.

Verify Primary: Disconnect the backup and examine whether the primary is w  orking properly.

Verify Backup: Disconnect the primary and examine whether the backup is working properly.

10.2 Card Backup

You can configure card - level hot backup for output cards within the same screen, enabling the backup card to

take over as the primary car d in case of a failure.

Applicable Products

MX6000 Pro, MX2000 Pro

Prerequisites

The primary and backup output cards must be of the same model and firmware version.

Controller backup and card backup are mutually exclusive. You can only configure one type o f backup at a time.

Related Information

When backup is set for the cards, only the primary card can detect multifunction card and light sensor

information. The backup cards cannot detect or read this information.

Operating Procedure

Step 1 Select a screen from the project list and then select Backup .

Step 2 Inthe Backup Settings section, select Card Backup from the dropdown menu.
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Step 3 Set a backup card for the primary.

Figure 10-2 Card backup

» Backup Settings

MXG000 Pro_1 Card Backup

OuT 1 | MNone

ouT 2 None
Ethernet Backup
ouT 2
ouT 4 OuT 4
ouT 5
ouT 7
ouT s

ouT 5

MNone

MNone

Step 4 Click Verify Primary or Verify Backup to examine whether the controlle rs are working properly.

Verify Primary: Disconnect the backup and examine whether the primary is working properly.

Verify Backup: Disconnect the primary and examine whether the backup is working properly.

10.3 Ethernet Port Backup

You can configure Ethernet po rt hot backup within the same controller or output card, enabling the backup port
to take over as the primary port in case of a failure.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Prerequisites

Controller backup and Et hernet port backup are mutually exclusive. You can only configure one type of backup at
a time.

Related Information

When Ethernet port backup is set up, only the primary port can detect multifunction card and light sensor
information. The backup port s cannot detect or read this information

Operating Procedure

Step 1 Select a screen from the project list and then select Backup .
Step 2 In the Backup Settings section, select Ethernet Backup from the dropdown menu.

For card-cased controllers (MX6000 Pro and MX2000 Pro), you need to first select Card Backup before

configuring Ethernet port backup for the cards.
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Figure 10- 3 Ethernet port backup

» Backup Settings
Card Backup
| None

ALIT 2 MNone

Port( =2 1) Ethernet Backup 4

Port( ouT 2
Custom ouT 4
ouT 5
ouT7
ouTs

QuT 5

ouT7? None

OuT 8 None

Select an option from the sub - menu of Ethernet Backup .

Port (1~20) XX (21~40): Split Backup where Ethernet ports 21 to 40 are the backups to Ethernet ports 1 to 20.

Port (1 XX 2, 3K 4...): Sequential Backup where Ethernet port 2 is the backup to Ethernet port 1, Ethernet port 4
is the backup to Ethernet port 3, and so on.

Custom: Select a controller or output card from the project list, and then you can drag and drop the port icon in
the port list to customize the backup settings. You can also select a backup mode first and then adjust the

backup settings according to your needs.

Figure 10-4 Port list

Port List & split Backup 20 sequential Backup

Primary

E Note

You can click Split Backup or Sequential Backup on the right side of the port list to switch between backup
modes.
When hovering the mouse over the line between the Ethernet ports, you will see an icon ( .). Click the icon to

delete the backup relationship between the ports.

Click Verify Primary or Verify Backup to examine whether the controllers are working properly.

Verify Primary: Disconnect the backup and examine whether the primary is working properly.

Verify Backup: Disconnect the primary and examine whether the backup is working properly.
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11 Preset Management

11.1 Save Presets
After completing the display effect adjustment, you can save the data onthe  Source, Layout , Processing and
Screen Settings pages as presets so that these data can be direct ly applied in the future. Up to 128 presets can

be saved in VMP.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Related Information

The preset of a specific controller can only be applied by this controller itself and the  preset of a screen can be

applied by all the controllers of the screen.

Operating Procedure

Step 1 Select Preset.
Step 2 On the preset management page, click to enter the page shown in Figure 11-1.

To go back to the preset management page, click a blank area in the properties area.

Figure 11-1 Preset management

Preset

1 Preset 1 5 Preset 3

H 3] =)

Step 3 Click the icon of a preset.
Step 4 Select the data you need to save. You can also enable Transition Through Black as needed.
If the preset you selected is not empty, the original data will be overwritten.

Step 5 Click Save.

11.2 Apply Presets

Apply a saved preset to quickly complete settings of the parameters onthe  Source, Layout , Processing and

Screen Settings pages.
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Applicabl e Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Related Information

The preset of a specific controller can only be applied by this controller itself and the preset of a screen can be
applied by all the controllers of the screen.

Operating Procedure

Step 1 Select Preset.
Step 2 On the preset management page, double -click a preset and wait it to finish loading.

The preset that is being used has a at the top right.

Figure 11-2 Apply presets

Preset 1 2 Preset 2 3 Preset 3

- EEEEY E =]

11.3 Manage Presets
Select Preset and do the following operations as needed.

Modify a Preset

Select a preset. In the properties area, change the related information and click  Save.

Delete a Preset

Right- click a preset and select Delete from the pop -up menu.

On the preset management page, select a preset and click Delete in the properties area.

Clear Presets

Right- click a preset and select Delete All from the pop -up menu.

www.novastar.tech PAGE S



VMP Vision Management
Platform User Manual

12 Screen Monitoring

12.1 Overall System Health

You can assess the operational status of each component within the entire LED display system.

Operating Procedure

Navigate to Monitor > Health to access the relevant information. The figure below uses the MX6000 Pro as an
example:

[ Health
© Alarm

Screen v
- Normal

. B Fibe Converta |
§ Temperature

V' Voltage it Cowere 2
|/ Packet Loss EEG: Controller
. ) Total

. Normal
. . Alarm
Fault

5] Source

©3 Controller

b Convara 5

e P Comvartr &
. Cabinet

88 iber Converr 7 Total
. . Normal

. Alarm

Fault

s ot 0

8 it Convartr 10 Accessory

Total
B Fiber Convertr 11 Normal
. . Fault

e i Comvertr 12
85 Pt Comvertr 15
85 Fibe Convertr 14
865 Fibe Comvarter 15

S G 6
: B Normal
® Alarm
Fault

® Unknown

4  System Link Diagram

This diagram provides a c lear visual representation of the connection status and locations of the controllers
and fiber converters within the selected screen. A green indicator signifies normal operation; yellow
indicates an alarm; red denotes a fault; and gray represents unknown  status. This allows you to quickly

pinpoint any issues if they arise.
4  Health

Shows the overall system health status. It displays Normal if all controllers, cabinets, and accessories are
operating without issues. If there are alarms but no faults, it shows  Alarm . If any faults are detected, it

displays Fault .
Controller

Shows the total number of controllers and provides a breakdown of those in normal operation, those

with alarms, and those with faults.
Cabinet
Displays the total number of cabinets and their  status, indicating the number in normal operation, those

with alarms, and those with faults.
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Accessory

Lists the total number of accessories, along with the count of those functioning normally, those with

alarms, and those experiencing faults.
12.2 View Alarm Information
You can view the system alarm records.

Operating Procedure

Navigate to Monitor > Alarms to check the current alarms. You will see details such as severity, count, summary,

time elapsed, possible causes, and recommended actions. Perform the neces sary actions based on this.

Figure 12-1 Alarms

(=) Health ' View History Sort By Type (2 Export )

© Aloarm
] Screen v Severity + G W Description Cause Suggestion

1. High operating temperature of controller, 1. Check the controller's operating environment te..
2. Fan blocked by the dust or foreign objects... 2. Clean the dust or remove foreign objects from 1.

S Tsmpaatoes) Foult Mainboard temperature 100 high

V Voltage T ;
1. Noin ource signal

Foult Input source disconnected. i 2 fhon o vl
|/ Packet Loss OROE TP
1. Poor connection at the ou 1. Check the Ethernet cable

- > Foult Ethernet output port disconnected.
2] Source Ll TIEL QTP POTL Clacomecir 2. Ethernet cable is disconnected.. 2. Replace the Ethernet cable.

= Controller
5 Ethernet output port connected. None None

%) Diagnosis

& settings

25 v items/page 1-4 of 4 items

4  Search records

You can search by controller name (including IP), controller type, exception level, summary, or problem

description.
4 View history

Select View History to display all past alarms. If unselected, only unreso Ived alarms are shown.
4  Sortalarms

Choose By Type or By Time from the drop -down menu to organize the alarm records.
4  Reset records

Click ﬂ then select Reset in the popup window to clear existing records, refresh to the latest status, and

generate alarm information.

4  Export records
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Click Export to save all alarm records of the screen. The file will be in .CSV format.

12.3 Monitoring Status

12.3.1 Screen Monitoring

You can monitor the LED screen's receiving cards, cabinets, and modules from multiple metrics to confirm the

operational status of the screen.

Prerequisites

Certain screen monitoring tasks require cooperation with receiving cards and accessories. The specifics are as

follows.
Monitoring Receiving Card Requirements Other Requirements
Cabinet HUB Must work with receiving cards including XA50 N/A
board Pro, CA50E, or A10s Pro and its derivatives
temperatur e (version V1.5.3.0 or later) for effective
monitoring.
Receiving card Must work with receiving cards including XA50 N/A
PHY Pro or CA50E (version V1.5.3.0 or later) for
temperature effective monitoring.

- Monitoring is supported if the module is a smart module or is equipped with the TBS614S
Module wiring

chip.
Module The module must have a temperature
temperature sensor.
Module voltage The module must have a voltage sensor.

Support for monitoring requires custom versions

Cabinet of the XAS0 Pro, CAS0E, A10s Pro and its The cabinet must be connected to a

humidi S . humidi .
umidity derivatives. For more details, please contact umidity sensor

Cabinet power NovasStar tech support. N/A

supply

_ The cabinet must be connected to a
Cabinet smoke
smoke detector.

Related Information

When collecting data effectively, the topology diagram uses color to distinguish the status. You can view the
legend in the bottom right corner of eac h tab: green indicates normal, yellow for alarms, red for faults, and gray

for unknown. Hovering the cursor over a cabinet will also display detailed monitoring values.

Operating Procedure

Navigate to Monitor > Screen. Depending on your needs, perform the following actions to view screen

monitoring information:

www.novastar.tech PAGE gt



VMP Vision Management
Platform User Manual

. Switch to the Temperature tab to view screen temperature details. Specific values are shown in the properties
area.

: The receiving card temperature.

(& : The operating temperature of the cabinet's HUB board.

: The module temperature.

i
: The receiving card PHY temperature.

Filter 2 [ Pagel v
[&] Health

Cabinet @
@ Alarm " Mixed
7] screen v
§ Temperature
V Voitage
|/ Packet Loss
5] source
s Controller
% Diagnosis

@ settings

Normal

§ unknown
Updated 2025-09-11 19:26:27

. Switch to the Voltage tab to view screen voltage details. Specific values are shown in the properties area.

: The cabinet voltage.

E: The module voltage.

Filter "2 @ Page1l
[&] Health

Cabinet hd
@ Alarm Mixed
] Screen -
8 Temperature
¥ Voltage
|/ Packet Loss
2] Source
e Controller | Cabinet Setfings
& Diagnosis ! Blackout
2 | Fi
& Settings |

Normal

Normal

Fault

Unknown

Updated 2025-09-1119:27:11

. Switch to the Cabinet Power tab to monitor the status of the cabinet's power supply. In the properties area, you
can check the status of each power supply.
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Switch to the Packet Loss tab to monitor accumu lated bit errors on the receiving cards. Any abnormal receiving

card will appear in yellow on the topology with the error count indicated. You can view specific cumulative errors

in the properties area. Click to reset the error count and start monitoring again, and click to view the

packet loss curve.
Switch to th e Module Wiring tab to monitor the wiring of modules.

Switch to the Cabinet Humidity tab to monitor the ambient humidity of the cabinet. In the properties area, you
can check the humidity level. Excessive humidity can lead to oxidation and corrosion of the internal circuit

boards and components in the cabinet, potentially reducing performance or even causing damage to the device.

Switch to the Cabinet Smoke tab to monitor the cabinet for smoke. Smoke acts as a warning signal for electrical
component short ¢ ircuits. By monitoring it, short - circuit issues can be quickly identified, allowing for timely
replacement of components and effectively preventing fires.

E Note

By selecting a target in the topology diagram, you can view detailed values for screen monitori  ng items,

cabinet location, total runtime, and current runtime in the properties area.

In the Cabinet Settings area, you can set the cabinet to black out, freeze the display, or show a test pattern.

12.3.2 Input Source Monitoring

Navigate to Monitor > Source to view details about the number of currently connected input sources, the type of
interface, resolution, and frame rate for your primary and backup controllers. You can also click to enlarge the

input source preview.

4 ShowAll % Packup
(=] Health

© Alarm v MX40 Pro_1

] Screen v

8 Temperature HDI

V Voltage ‘

|/ Packet Loss "/ i

£ T ,
5] source @3840:2160@60.00Hz SN & ’ = 3840°2160@60.00Hz 3840°2160@60.00Hz 40+2160@50.00Hz
= Controller
%) Diagnosis

& settings

12.3.3 Controller Monitoring

Navigate to Monitor > Controller to access the relevant information. The figure below uses the MX6000 Pro as

an example:
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Figure 12-2 Controller Monitoring

- Layout Source Correction Processing  Screen Seftings Backup Monitor Schedule
(ackou s

p =B
% Freeze = 5 G == o |22

@ Pagel v

Controller
[ Health

© Alarm
MX6000 Pro_1
L]

5
4 Temperature 1h56m

[ Screen

2h3m
V Voltage

MX6000 Pro_1 &b 192168013

] Source

Input Slot Fans
©= Controller IN1 ouT1

Output Slot Fans
~, Diagnosis

7o out2 card
@ Settings

IN1
IN2
IN3
IN4
INS
ING
IN7
IN8
out1
ouT2
out3
ouT 4

POWER1 POWER2

. Check the status of the connectors on the rear panel of the controller.

. Check the controller's name, current uptime, total uptime, mainboard temperature, mainboard voltage, and fan
status.

. Check the temperature and voltage of the cards.

. Enable or disable Controller Finder . You can identify the controller by toggling on the switch (  #0)). In the
project list, right - click on the co ntroller to set the LCD display color from the pop -up menu.

12.4 System Diagnostic

Perform diagnostics on the selected screen. You can choose to diagnose various items including LED error

detection, origin data comparison, controller self - check, monitoring item s, and receiving card signal interruptions.

Prerequisites

Before conducting LED error detection, ensure the following:
. The module is a smart module.
. The receiving card firmware supports LED error detection.

., LED error detection is enabled in Cabinet Tool.

Operating Procedure

Step 1 Select a screen from the project list and then goto  Monitor > Diagnostics .
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Layout Source Correction Processing  Screen Seftings Monitor Schedule

@ Blackout

‘ : Fiter @ @ Pagel ] .
L] System Diagnosis
[ Health Y J

© Aarm Last Diagnosis: -—
[ Screen v
8 Temperature Pending
V Voltage
5] Source
== Controller ~ Compare Origin Data
% Diagnosis ~ Controller Diagnosis
& Settings ¥ Packet Loss

Monitoring Values
Start

Cabinet Settings

Normal

Origin Data + Create & Compare ¥ Restore

Controller with Changes Cabinet with Changes  — Ry Card with Changes Module with Changes

Step 2 In the System Diagnostics on the right, select the diagnostic items you wish to perform.

. LED Errors: Diagnoses the number of dead pixels in each module.
When a cabinet is selected in the topology, diagnostics are based on the selected cabinet.
If no cabinet is selected, diagnostics are performed on all cabinets by default.
. Compare Origin Data: Compares whether the saved origin data values differ from the current  values.
. Device Diagnostics: Performs a self - check on the controller, with results categorized as Normal, Alarm, or Fault.

. Monitoring Values: Diagnoses current results of monitoring item values to determine if there are any anomalies

in the system.

. Receiving Card Signal Interruptions: Counts the number of times a receiving card experiences signal

interruptions without going offline.
Step 3 Click Start to carry out the system diagnostics based on the selected options.
Step 4 Click View Report to obtain a diagnostic report file (.pdf) for the selected screen.

Step 5 Click the function icons on the left to view corresponding diagnostic results.

. B==L: LED error detection. The topology will display faulty modules in yellow with the number of dead pixels

labeled. At the bottom of the int erface, you can check the specific number of faulty modules and dead pixels.
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LED Errors

Module Errors 8 Dead Pixels

, : Origin data comparison. View specific data changes for controllers, cabinets, receiving cards, and modules

at the bottom of the interface and perform the necessary actions.

MX40 Pro_2_P1_1

Cabinet Data Change
lo changes
Rv Card Data Change
lo changes
Module Data Change
Module Location: P1_1_1

Origin Data + Create EF Compare ¥ Restore

Controller with Changes 1 Cabinet with Changes 0 Rv Card with Changes Module with Changes

Click to select Create System Origin or Export System Origin . Selecting both will export the

saved origin data.
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Create System Origin lets you manually save the current data as origin data, overwriting the existing

values.

Export System Origin  allows exporting the current origin data as a file (.opd).

Create

« Create System Origin Export System Origin

Click to select Compare with System Origin  or Compare with Origin File . Upon
completion, a comparison file ((CSV) is generated.

Compare with System Origin  compares the current data values with the latest saved system origin

values.
Compare with Origin File compares the current data values with a selected origin file's values.

Compare

@ Compare with System Origin Compare with Origin File

Click to select Restore to System Origin  or Restore to Origin File
Restore to System Origin reverts the current data values back to the latest saved system origin values.
Restore to Origin File reverts the current data values to a selected origin file's values..

Restore

@ Restore to System Origin Restore to Origin File

=
i=al: Device diagnostics result. The bottom of the interface shows the  counts of controllers categorized as

normal, alarm, or fault.
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MX40 Pro_1 (Backup) MX40 Pro_2 (Primary)

Controllers are running properly ! Controllers are running properly

Controller Diagnosis

Normal 2 Alarm 0 Fault

. 48 Receiving card signal interruptions. After diagnosis, faulty receiving cards are shown in yellow on the

topology with the interruption count labeled. The interface displays the specific cou  nt of receiving cards

with signal interruptions and the number of interruptions. Click E to reset the interruption count to zero
and start a new count.

=

Signal Interruption f

Rv Card with Inferruptions Signal Interruptions

E Note

You can also blackout, freeze, or enable test patterns for cabinets under the  Cabinet Settings section.
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12.5 Monitoring Settings

12.5.1 Monitoring Items

Select a screen from the project list, then choose Monitor > Settings . Then, toggle on or off Packet Loss as

needed.
On: The screen monitoring page will show and monitor packet loss on the receiving cards.

Off: The screen monitoring page will not include packet loss monitoring.

Monitoring Parameters

Packet Loss ]

12.5.2 Monitoring Strategy

To configure the monitoring strategy, select a screen from the project list and go to Monitor > Settings . In the
Monitoring Strategy  section, you can set actions to be automatically taken when abnormal values are detected,
temporarily reducing risk. The specific monitoring strategies available depend on the capabilities of the receiving

card being used.

1. If the cabinet or receiving card temperature exceeds the set threshold, the screen brightness will

automatically reduce to the specified level to prevent overheating.
2. If smoke is detected in the cabinet, the system will automatically power off the screen.

3. If there is a power failure in 0 ne of the cabinet's power supplies, the screen brightness will automatically

reduce to the set level.

E Note

When the Brightness Limit feature is enabled, the resulting brightness application in the monitoring strategy will

be based on a percentage of the b rightness limit.

Monitoring Strategy

When Rv card temperature exceeds 120.00°C Reduce screen brightness fo

12.5.3 Email Alarms

Email alarms can be configured to notify you via email whenever there are changes in the system, such as when

an alarm is triggered, a fault occurs, or normal operation is restored.
Step 1 Select a screen from the project list and then goto  Monitor > Settings .
Step 2 Toggle the email alarms on or off in the Alarm Email section.

Alarm Email [ ]

Notification Frequency 10 minutes 24-Hour Limit for Same Fault /Alarm Emails 3times

Recipient Add

Email Address Verified Action

Step 3 Configure the email notification settings and check the sender email address:
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Notification Frequency: Options include Immediate , 3 minutes , 5 minutes , 10 minutes , 30 minutes , 1 hour , or a

custom frequency.

24-Hour Limit for Same Fault/Alarm Emails: Options include: 1 time, 3 times, 5 times, 7 times, 10 times , and No
limit .

Step 4 Set recipient email addresses, with a maximum of 5 recipients allowed.
1. Clickthe Add button, and then enter the email address in the pop -up window.

2. Click IEI to send a verification email to the specified address and complete the verification by checking your

email.

3. After the settings, click OK.

Recipient Add

Add Recipient
Email Address

Enter an email address and verify

Recipient

13 Display Schedule

13.1 Create Brightness Schedule

You can create a brightness adjustment schedule for the LED display screen. When a light sensor is connected to
the system, it can automatically adjust the brightness of the LED screen based on the real -time ambient ligh t
conditions. This adjustment occurs within a predetermined time frame, with the sensor measuring the ambient
light brightness and referring to a mapping policy that correlates the LED display brightness with ambient light

levels.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Operating Procedure

Step 1 Select a screen from the project list and then select Schedule.

Step 2 Click Create Schedule , select the Brightness tab, and then set the date and time range.
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Figure 13- 1 Create brightness schedule

Create Schedule

Type Brightness Preset Diagnostics

Date 2025-03-12 Full-day
Time 08:00
Adjust By Light sensor

Repeat o

Step 3 Set the screen's active time. You can either input custom times or use the local sunrise and sunset times for

scheduling.

In the Sunrise/Sunset section, click Access Location to retrieve the current screen's latitude and longitude along

with the local sun rise and sunset times. You can also add notes for the location.
sunrise/Sunset
ccess Locarti }

108.928600°

34.258300°

Xi'an

Step 4 Specify how the brightness is adjusted, by Light sensor , or by Specified brightness

If you choose to adjust by a light sensor, remember to configure the brightness schedule on the right sid e of the

interface (referto Step 5 to Step 6).
Step 5 Select one of more light sensor s under the Automatic Brightness  section.

Selectable Range: Light sensors connected to multifunction cards on each controller/output card that are online

in the current project.

B Note

When multiple light sensors are selected, the system calculates the average ambient brightness from all sensors

to adjust the screen brightness according to the brightness schedule.

If multiple controllers connected to light sensors are placed in environments with differing brightne  ss levels under

the same screen, ensure proper communication between controllers to prevent inconsistent screen brightness.

Step 6 In the Brightness Schedule section, set up the mapping between ambient brightness and screen brightness.
When the light sensor detec ts a specific ambient brightness, the screen brightness will adjust to the

corresponding value.
1. Choose the brightness adjustment method: Linear or Stepwise .

Linear: Continuously calculates the average brightness between two adjacent ambient levels based  on the

measurement rules and adjusts the screen brightness according to the brightness schedule.
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Stepwise: Adjusts the screen brightness only at the endpoints of two adjacent ambient levels per the

brightness schedule.

Figure 13- 2 Brightness schedule

Automatic Brightness

Connected Light Sensors

Brightness Schedule

@ Linear

_ + Batch Add

Amb..tne Screen..ightness

20Lux 40.0%

E!

1218Lux

&

b

2416Lux

=

3614Lux

E

f

4812Lux

=

6010Lux

E!

!

7208Lux

=

8406Lux

E!

!

9604Lux 72.0%

=

10802Lux 76.0%

E]

f

12000Lux 80.0%

E

2. Add new brightness schedules, with up to 29 entries supported. You can choose Add or Batch Add .

Batch Add: Click Batch Add , then set Ambient Brightness , Screen Brightness , and the number of segments

in the pop - up window.

Batch Add X

Changes in ambient, screen brightness, or segments have occurred. A new
brightness schedule will be required.

20Lux
12000Lux

Add: Click Add to create a new brightness schedule and the adjust the values for Ambient Brightness and

Screen Brightness .

Mo, Amb..tness Screen.ightness

1 20Lux 40.0%

E Note

When all the cabinets of the screen support the multi - mode function and use the same NCP file, you can
manually link the brightness schedule to the multi - mode and display data based on the maximum brightness of

the multi - mode.
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Step 7 Specify if the schedule should repeat and provide the end time for the repetition.
Step 8 Click OK once you are done. The created schedule will be displayed in the sche dule chart.

Month

You can click on the top - left corner to switch between daily view, weekly view, and monthly

view to review the overall schedule plan.

< 202404 B e Create Schedule

. 10 "

0800 Light sensor 08:00  Liaht sensor 8: Liaht sensor

14 15 16 17

08:00  Liaht sensor Light sensor 08:00  Light sensoi sensor Light sensor Light sensor 08:00  Liaht sensor

26

Liaht sensor :00  Liaht sensor 00  Liaht sensor Liaht sensor Liaht sensor 08:00 Light sensor 00  Liaht sensor

Light sensor
edule

The schedule and subsequent schedules

Step 9 Right-click a schedule in the chart to Edit or Delete it.

Edit: You can edit the Current schedule or Current and follow -up schedules .

Delete: You can delete the Current schedule , Current and follow - up schedules, or All schedules .

Step 10 To activate the schedule, please toggle on Schedule in the upper right corner of the chart.

Figure 13- 3 Schedule

Day Week Month < 2024-04-11 5 > Schedule Create Schedule

08:00 Presetl:Preset]

E Note

Brightness schedul e and HDR 2084 cannot be enabled at the same time. If brightness schedule is enabled after
HDR 2084 is selected, the HDR function will be disabled.
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13.2 Create Preset Schedule

You can create a predetermined schedule for the LED screen, enabling automatic switch ing of different presets

according to the specified timetable.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Prerequisites

You need to save a preset for the screen before creating a preset schedule.

Operating Procedure

Step 1 Select a screen from the project list and then select Schedule.

Step 2 Click Create Schedule , select the Preset tab, and then set the start date .

Create Schedule

Type Brightness Preset Diagnosis

Date 2025-09-11
Time 08:00
Switch To 1.Preset 1

Repeat o

Step 3 Set the start time for the schedule, with options to enter it manually or use local sunrise/sunset times.

In the Sunrise/Sunset section, click Access Location to obtain the current screen’s latitude, longitude, and

sunrise/sunset times. You can also add notes for the location.

Sunrise/Sunset

108.830931°

34.2223513°

Xian

Step 4 Select the preset to be applied.
Step 5 Specify if the schedule should repeat and provide the en d time for the repetition.

Step 6 Click OK once you are done. The created schedule will be displayed in the schedule chart.
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Month

You can click on the top - left corner to switch between daily view, weekly view, and monthly

view to review the overall schedule plan.

Day  Week | Month < 202404 5 Create Schedule

. 0 1 2 3
TR . sensor 08:00 Liaht sensor :00  Liaht sensor 00  Liaht sensor

14 15 16

08:00  Light sensor 08:00  Light sensor 08:00  Light sensor Light sensor iaht sensor 08:00 Light sensor

Liaht sensor

4
Light sensor :00  Liaht sensor 08:00 ensar 08:00  Liaht sensor

The schedule and subsequent schedules

Step 7 Right-click a schedule in the chart to Edit or Delete it.

Edit: You can edit the Current schedule or Current and follow -up schedules .

Delete: You can delete the Current schedule , Current and follow - up schedules, or All schedules .

Step 8 To activate the schedule, please toggle on Schedule in the upper right corner of the chart.

Figure 13-4 Schedule

Day | Week Month < 2024-04-00 5 > < - @ Create Schedule

13.3 Create Diagnostic Schedule

You can set up a diagnostic schedule for LED screen to conduct regular diagnostics based on a defined schedule

and selected di agnostic items.

www.novastar.tech PAGE JR:S]



VMP Vision Management
Platform User Manual

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Operating Procedure

Step 1 Select a screen from the project list and then select Schedule.

Step 2 Click Create Schedule , select the Diagnostics tab, and then set the start date.

Create Schedule

Type Brightness Preset Diagnostics

Date 2025-03-12
Time 08:00
Diagnostics Compare Origin Data, Co..

Repeat L]

Step 3 Set the start time for the schedule, with options to enter it manually or use local sunrise/sunset times.

In the Sunrise/Sunset section, click Access Location to obtain the current screen's latitude, longitude, and

sunrise/sunset times. You can also add notes for the location.

Sunrise/Sunset

108.830931°

34.222513°

Xian

Step 4 Configure the diagnostic items, including: LED Errors (only supported by smart modules), Compare Origin Data

(optional), Device Diagnostics (optional), and Monitoring Values (mandatory).
Step 5 Specify if the schedule should repeat and provide the end time for the repetition.
Step 6 If email alarms are set up on the monitor page, you can opt to send diagnostic results via email.

Step 7 Click OK once you are done. The created schedule will be displayed in the schedule chart. When setting multiple

diagnostic schedules, ensure there is at least a 5 - minute gap between each.

. Day Week Month . . i .
You can click on the top -left corner to switch between daily view, weekly view, and monthly

view to review the overall schedule plan.
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Automatic Brightness

week Month < = schedule @ Create Schedule
Connected Light Sensors

No Sensor

Brightness Schedule

® Linear
Stepwise

+ Add

Screen.ightness

b

20Lux 40.0%

E

1218Lux 44.0%

E

® 15 14 15
® 08:00 © 08:00 D ® 02:00 Diagnostics ® 02:00 Diagnostics 2416lux  48.0%
® 18:05 N * 18:05 i

h

[E

b

3614Lux 52.0%

E

The schedule
The schedule and subsequent schedules
19 All schedules 22

® 0800 Diag * 08:00 ® 08:00  Diagnostics ® 0800 Diagnostics 7 7208Lx  640%
® 1805 Diag ® 1805 D

4812Lx  56.0%

El

h

6010Lux  60.0%

[E

b

E

h

8406Lux  68.0%

E:

b

9604Lux  72.0%

=

2 27 28 29 10802Lux  76.0%
® 08:00 g ® 08:00  Di ® 08:00 Diagnostics ® 08:00  Diagnestics
® 1805 g ® 18:05 i

El

h

12000Lux  80.0%

[E

Sunrise/Sunset

Log [ 2025-05-1200:00:00 - 2025-03-12 155552 Q Time, apply status, screen name. & History Charts

Longitude 108.928600°

Latitude 34.258300°

Step 8 Right-click a schedule in the chart to Edit or Delete it.

Edit: You can edit the Current schedule or Current and follow -up schedules .

Delete: You can delete the Current schedule , Current and follow - up schedules, or All schedules .

Step 9 To activate the schedule, please toggle on Schedule in the upper right corner of the chart.

Figure 13-5 Schedule

Today Day Week Month ¢ 2025-03-12 [ » Schedule Create Schedule

Wl 18:05 Diagnostics

13.4 Check Schedule Log

You can check the schedule log and history charts.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro
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Operating Procedure

Select Schedule and at the bottom of the page, do the operation as needed.

Figure 13-6 Log

Log [ 2025-03-12 00:00:00 - 2025-03-12 13:53:52 Q 5 ‘ History Charts

4  Search records
Enter the key words in the search box.
4 Query records
Click the time widget and set the start and end time.

4  History charts

Click and select a specific date to access the hist ory charts displaying the brightness
schedule, preset schedule, and diagnostics schedule log. Please note that you can only view the history on a

daily basis.

Figure 13-7 History charts

History Charts

Select Date 2025-09-10
Brightness - Scheduled Brightness - Execution Brightness

100.0% -
80.0% —
60.0% —
40.0% —
20.0% -

0.0%
02:00 08:00 20:00

Schedule

00:00 01:00 02:00 0300 0400 05:00 0600 07:00 0800 09:00 10:00 11:00 1200 1%00 14:00 15:00 1&00 17:00 18:00 19:00 20:00 22:00 2300

Execution

Diagnosis

Schedule Diagnosis

00:00 01:00 02:00 0300 0400 0500 0600 07:00 0800 09:00 10:00 11:00 1200 1%00 14:00 15:00 1600 17:00 18:00 19:00 20:00 21:00 22:00 23:00

Execution Diagnosis

4  Export records

Click Export , select a file page, set a file name, and click Save.
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14 Calibration Coefficient Management

From the menu bar, choose Tools > Coefficient Management and do operations such as uploading, saving,

adjusting and reading the coefficients. You can also check the module flash status.

< Baek Coefficient Management

Module Flash @& 2 @ Pagel v Display

Brightness

Coefficient Management

4L

Upload Coefficients

Saveto HW

14.1 Check Module Flash Status

When replacing modules or reading back coefficients from the module flash, you have the option to visually

inspect the status of the module flash.
Step 1 Select a screen from the project list.
Step 2 From the menu bar, choose Tools > Coefficient Management

Step 3 On the canvas, click to display the module flash status. Click = again to hide the module status. Click E

to refresh the module status.
¥ . Module flash is abnormal.

: Module flash is normal.

Figure 14-1 Check module flash status

Module Flash @ O
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14.2 Upload Calibration Coefficients

Upload the local calibration coefficient file to the current screen, cabinet or module and apply the coefficients to

the display effect.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Prerequisites

You can only upload coef ficients from page 1.

< fmPagel v
v Al

© Page 1 4=
© Page 2
© Page 3
© Page 4
©® Page s
© Page 6
© Page7
© Page8

MX6000 Pro_1-OUT 1 MX6000 Pro_1-OUT 2

To upload screen coefficients, make sure:

The screen configuration is done, the cabinets are not rotated, and there are no cabinet gaps or

overlapping.

The configured screen must be rectangular, and the top - left-corner coordinates o f the circumscribed

rectangle of the configured screen must be (0, 0).

To use the database file, you should prepare it in advance, and the resolutions of the configured screen
and the screen in the database must be the same and the database must be a scree n database.

To upload cabinet coefficients, make sure:

The target cabinets have cabinet IDs. You will need to configure cabinet ID manually if the target cabinets

have no ID.

Notice

During coefficient uploading, if the controller and/or receiving cards go offline, the uploading will fail.

If the coefficient uploading fails, the coefficients will not be saved automatically. You can manually save them as

needed.

Operating Procedure

Step 1 Select a screen from the project list.
Step 2 From the menu bar, choose Tools > Coefficient Management .

Step 3 In the Select Mode area, select the uploading range. The options include Screen, Cabinet and LDM.
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Figure 14-2 Select mode

» Select Mode

Cabinet LDM

(F2)

Step 4 In the Coefficient Management area, click and select one or more target calibration data file s (.db) from the
local computer.

You can select and batch import multiple coefficient files at once. When importing calibration coefficients for
cabinets or modules, the system will automatically match and upload according to the corresponding
cabinet/modul e ID.

Figure 14-3 Upload calibration coefficients

Coefficient Management

Upload Coefficients
Save to HW
Read

\ Export

When importing calibration coefficients for cabinets or modules, the system will automatically match and upload
them using the corresponding cabinet or module ID.

Upload calibration coefficients

Upload the coefficient file and apply it tothe display effect
(" Upload File )

Match & coef File & validation \¢  Calibrated ¢ Resolution ¢ coef Type & Action

Full-Screen. 50312140346  Successf, Screen 384°768px Brightness and chroma {7

[ Cancel )

When trying to import the cabinet/module calibratio n coefficient, but the cabinet/module ID does not match the

ID in the coefficient file, you'll need to manually select and upload.

In this case, the Match will show as not matched and File ID will be empty. You'll need to click the File ID
dropdown menu and select the appropriate file ID manually. Ensure that the selected coefficient file is compatible
with the cabinet or module before making a selection.
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Upload calibration coefficients

Step 5 Click OK to upload the coefficients to receiving cards.

14.3 Edit Calibration Coefficients

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Prerequisites

Calibration coefficients are available.

Cabinet configuration is done and the cabinets stay online.

Operating Procedure

Step 1 Select a screen from the pro ject list.
Step 2 From the menu bar, choose Tools > Coefficient Management

Step 3 Inthe Select Mode area, select Pixel.

Figure 14-4 Select mode

v Select Mode

Cabinet LDM

(F2) (F3)

Step 4 In the topology, click to select a cabinet.

Step 5 In the displayed window, select the target pixels and enter the parameters inthe  Coeffici ent Management area

to adjust the proportion relationship of the red components, green components and blue components in RGB

The calibration coefficients of the selected pixels will be overridden and changed to the values you set.
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Figure 14-5 Pixel calibration coeffi cients

RRIRG RB GR GGGB BRBGBB [1 v|] ® O x

2 23 24 25 26 27 28 29

Table 14- 1 Parameter relationship and value range

/ Red-R Green-G Blue-B

Red-R RR (512- 2047) GR (0- 255) BR (0- 127)

Green-G RG (0- 255) GG (512- 2047) BG (0- 255)

Blue-B RB (0- 127) GB (0- 127) BB (512 - 2047)
Table 14- 2 Icon description

Icon Function

- The step of single increase or decrease. Use it together with ':E:' ':::' .

® O Increase or decrease the coefficient value of the selected pixel.

Click to close the pixel topology.

14.4 View Calibration Effect

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Related Information

If brightness correction has been done for the screen, the screen brightness can be adjusted in nits. Otherwise, it

can be adjusted only in percentage.

Set the Display Content

In the Display area, you can adjust th e screen brightness to clearly see the actual calibration effect change at

each grayscale. You can also switch the color to see the uniformity of a single color and the entire display image.
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Figure 14-6 Set display content

Display

® 1000%

Brightness: Adjust the screen brightness.

Display image: Set the image displayed on the screen. By default, the current input source is being displayed

(W). You can switch to a monochrome display in white, red, green, and blue.
To do so, simply press the shortcut keys W, R, G, B, and Tab.

Show locating cursor: When the switch is setto  ®0, the selected area on the screen will display blue borders.
This helps you quickly identify the cabinets, modules or pixels that you are currently operating.

Enable and Disable Calibration Effect

In the Calibration area, you can turn on or off the calibration switches and then view the display effects before

and after the calibration.

The calibration switches include Brightness Calibration , Brightness and Chroma Calibration , Full- Grayscale
Calibration and Low - Grayscale Calibration . The actual displayed switches depend on the existing coefficient

types of the screen.

Figure 14-7 Calibration switches

Calibration

The Brightness Calibration and Brightness and Chroma Calibration  are mutually exclusive and cannot be

enabled at the same time.
14.5 Save Calibration Coefficients

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Notice

During coefficient saving, if the receiving cards go offline, the saving will fail.
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Related Information

To manage changes to the factory cal ibration coefficients, users can contact NovaStar tech support to apply for a
license and set a valid period. During the valid period, coefficients can be saved in the module's flash memory.

Otherwise, they can only be saved in the user area of the receivi ng card's flash memory.

To activate the license, place the file in the directory:
Windows: Ci\Users\YourUsername\AppData\Roaming\VMP\Datas

Mac: /Users/ Your User Name/Librar y/Application Support/VMP/Datas

B

Operating Procedure

Save the calibration coefficients of the current screen, cabinet or module to the receiving card to avoid

calibration effect loss due to power failure.
Step 1 Select a screen from the project list.
Step 2 From the menu bar, choose Tools > Coefficient Management

Step 3 Inthe Select Mode area, select the saving range as needed, including Screen, Cabinet , LDM and Pixel.

Figure 14-8 Select mode

v Select Mode

Screen Cabinet LDM

(F2) (F3)

Step 4 In the Coefficient Management area, click Save to save the current display effect coefficients to the receiving

card.

The system automatically identifies the screen's coefficient types and saving locations. With an active license
within its validity period, you can save coefficients in the module's flash memory. Otherwise, they are saved in the
user area of the receiving card's flash memory. You can choose the extent of saving according to your needs.

Figure 14-9 Save coefficients

Save Coefficients

Save the current display effect coefficients to avoid data loss when powered off.

Save To:  User Area in Rv Card Flash

Coef Type: «/ Brightness and chroma

Step 5 Click OK.
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14.6 Read Back Calibration Coefficients

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Notice

During coefficient readback, if the receiving cards go  offline, the readback will fail.

Operating Procedure

Read back the calibration coefficients saved in the receiving card and apply them to the current screen.
Step 1 Select a controller from the project list.
Step 2 From the menu bar, choose Tools > Coefficient Managemen t.

Step 3 Inthe Select Mode area, select the reading range as needed, including Screen, Cabinet , LDM and Pixel.

Figure 14-10 Select mode

v Select Mode

Screen Cabinet LDM

(F2) (F3)

Step 4 In the Coefficient Management area, click Read to read the saved coefficients and apply them to the display

effect.

The system will automatically read the current screen's display effect coefficients. If the cabinet has module flash,
coefficients can only be read back from the module flash. If there is no module flash, they can only be read back

from the user area of the receiving card 's flash memory.

Figure 14-11 Read back coefficients

Read Back Coefficients

Read back the saved coefficients and apply them to the display effect.

Read From: User Area in Rv Card Flash

Coef Type: « Brightness and chroma

Step 5 Click OK.
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14.7 Export Calibration Coefficients
Export the calibration coefficients of the current screen, cabinet or module to the local computer. When the

receiving card is replaced or the new screen has the same speci fications, you can upload the exported calibration

coefficients directly to use.

Applicable Products

MX6000 Pro, MX2000 Pro, MX40 Pro, MX30, MX20, KU20, CX40 Pro

Prerequisites

You can only export coefficients from page 1.

0 < (] Page1 v
v Al

© Page 1 4=

© Page 2

© Page 3

© Page4

MX6000 Pro_1-OUT 1 MX6000 Pro_1-OUT 2 ® Page5
- R Sl |

© Page7
© Page8

To export screen coefficients, make sure:

The screen configuration is done, the cabinets are not rotated, and there are no cabinet gaps or
overlapping.

The configured screen must be rectangular, and the top - left - corner coordinates of the circumscribed
rectangle of the configured screen must be (0, 0).

To export cabinet coefficients, make sure:

The target cabinets must have cabinet IDs.
Notice

During coefficient exporting, if the controller and/or receiving cards go offline, the exporting will fail.

Operating Procedure

Step 1 Select a screen from the project list.
Step 2 From the menu bar, choose Tools > Coefficient Management

Step 3 Inthe Select Mode area, select the export range as needed, including Screen, Cabinet , LDM and Pixel.

Figure 14-12 Select mode

v Select Mode

Screen Cabinet LDM

(F2) (F3)

Step 4 In the Coefficient Management area, click Export to export the current display effect coefficients as a file (.db).
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The system will automatically read the existing coefficient types of the screen, allowing you to choose whether or

not to export them based on your needs.

Figure 14- 13 Export coefficients

Export Coefficients

Export and save the current display effect coefficients as a file
File Name:

Coef Type: + Brightness and chroma

Step 5 Click OK.
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15 Screen Maintenance

15.1 Maintain Controllers

Step 1 From the menu bar, choose Tools > Maintain and select the Controller tab.
Step 2 Select a screen from the project list on the left.

Step 3 Select the target controllers and perform the following operations as needed.

Figure 15-1 Controller maintenance

< Back Controller Cabinet Peripheral

Status & controller Name % T Model & & 1rsQ MAC Address Connected Ports & Connected Cabinets 4 Version % ¢ Action

® Online MX40 Pro_1 (Backup) MX40 Pro 192.168.0.10 00:11:22:35:38:11 20 o V150  More

® Online MX40 Pro_2 (Primary) MX40 Pro 192.168.0.11 00:11:22:35:38:12 20 8 V150  More

25 v items/page 1-2 of 2 items

4  Controller finder

Click Controller Finder and the LCD screen of the controller becomes green (default), which helps you

identify the controller quickly.
4 Firmware painter

a. Click Firmware Painter , select a single controller to start the firmware readback process.

b. Once the readback is successful, the system will automatically enter the firmware upgrade mode. Select
one or more controllers and click Start to update them so that they share the same fir mware version as

the current controller.
4  Factory reset (proceed with caution)

Click Factory Reset , then select one or more controllers. This action will restore all user settings to their
default values. Confirm by clicking OK to proceed with the reset.

4 Sync card firmware
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If the card firmware version does not match with the controller firmware version, you can click Sync Card
Firmware to sync the controller firmware to the card. Alternatively, you can resolve this issue by upgrading

the firmware.
4  Update fir mware
Click Update to update the controller's firmware by downloading from the cloud or uploading a local file.

Select the Cloud tab to view the latest version release notes and click Update to download and

automatically install the package.

You are up to date.

You already have the latest version (V1.5.0.T11.0307) of MX40 Pro installed.

Y’ 5
\ Cancel )

Choose the Local tab, click Upload File , and select either a firmware file (.img) or a compressed file (.zip)
from the pop -up folder. Verify the file name and version number, then click OK to proceed with the

update.

ite: (_ Upload File )

Name Current Version New Version

MX40 Pro_--- V1.5.0.T11.0307

During the upgrade process, the controller will automatically restart. In addition, please do not close VMP or

switch to another controller until the update is complete.

ENote:

When updating firmware, it's recommended to use a wired network. During the upgrade, connect the PC
and controller via a wired network. If you need to update via the cloud, ensure the PC is connected to the

internet.
All the controllers of a screen must be updated at the same time.

When upgrading card -based controllers (MX6000 Pro and MX2000 Pro), all of the cards must be updated at
the same time. If the cards span across different screens, the controllers that are under the same screen as

the card must also be updated together.
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Select File:

Name Current Version

via

4  Restart controller

Click Restart and click OK.

15.2 Maintain Cabinets

Step 1 From the menu bar, choose Tools > Maintain and select the Cabinet tab.
Step 2 Select a screen from the project list on the left.

Step 3 (Optional) Switch between the list and topology views by clicking the icon in the upper right corner, depending on
your preference.

Figure 15-2 Cabinet maintenance list/topology view
 Back Controller Cabinet Peripheral

[=] nczevita (v

Save Rv-card Config

Status & Controller $ Location $ & C Ff Firmware $ & Typ Resolution # ¢ Manufacturer $ Y Page $ Action

® Oniine MX40 Pro_2(192.168.011)  P1-1 V112,33 NC26 V1 192°192px Other Page1 ~ More
® Oniine MX40 Pro_2(192.168.011)  P1-2 A10s Pro V11233 NC26V1 192'192px Other Page1 ~ More
® oniine 2168011  PL-3 . ] V112.53 NC26 VL 192*192px Other Page 1 ~ More
® oniine 2.168.011)  Pl4 / > V11235 NC2.6V1 192°192px Other Page 1 ~ More
® Online: MX40 Pro_2(192.168.0.11) PL-5 V112.33 NC26V1 192°192px Other Page 1 v More
® Online MX40 Pro_2(192.168.0.11)  P1-6 A10s Pro V11235 NC26V1 192°192px Other Page 1  More.
® Online: MX40 Pro_2(192.168.0.11) P17 L J V112.33 NC26V1 192°192px Other Page 1 v More

® Online MX40 Pro_2(192.168.0.11) P1-8 Al0s Pro V11233 NC 2.6 V1 192°192px Other Page 1 v More:
Controller Cabinet Peripheral

NC2.6V1*8 (V
3 Refresh Q @ L P @ Pagel v Save Rv-card Config

Cabinet Info

MX40 Pro_2

Cabinet Settings

Step 4 Select the target cabinets and perform any of the following operations.

4  Check the cabinet information

Check the associated controller, daughter card (only applicable for card -based controller), location,

receiving card model, receiving card firmwa re, cabinet model, and cabinet manufacturer.

4  Cabinet display settings (topology view only)
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Select a cabinet through the topology view. In the Cabinet Settings section, click the Cabinet Test Pattern

dropdown menu and choose the display for the cabinet.
4  Cabinet painter

Click Cabinet Painter and select one or more cabinets so that other cabinets can have the same firmware

program and configuration file as the selected cabinet.
4 Update cabinet configuration file

On the Cabinet tab, select one or multiple cabine ts and click Update .

In the pop - up window, either select an existing cabinet data or click Import to upload a new NCP file.

Select an existing file: Choose an NCP file from the pop -up window and click Update .

Import a new file: Click Import to upload a new NCP file. You can select the import objects (multiple
selections are possible) from Local pack or Device pack . Once the upload is complete, return to the
Update interface, select the imported NCP file, and click Update .

aNote:

It is recommended to perform the update using a wired network.

When COEX series controllers work with the XA50 Pro, CAS50E, A10s Pro and its derivative cards, as well as

A8s Pro and its derivative cards, you can only perform the update using (.ncp) files.

When updating using NCP files, if the firmware of the receiving card matches the NCP file, you have the
option to update only the cabinet configuration file to enhance the update speed.

4  Restart cabinet
Click Restart and click OK.
4 Factory reset (proceed with caution)

The factory reset function is only supported on XA50 Pro, CAS50E, A10s Pro and its derivative cards (version
1.5.3.0 and above).

Select one or more receiving cards. If the selected receiving cards support the factory reset function and
have default parameters in the factory area, you can click Factory Reset to restore all user parameter s to
their default values. Any receiving cards that do not support this function will be automatically skipped, and

a reason will be provided.
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